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1.  Copyright Notice
© Copyright 2019 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are
the property of Esko Software BV. The material, information and instructions are provided
on an AS IS basis without warranty of any kind. There are no warranties granted or extended
by this document. Furthermore Esko Software BV does not warrant, guarantee or make any
representations regarding the use, or the results of the use of the software or the information
contained herein. Esko Software BV shall not be liable for any direct, indirect, consequential or
incidental damages arising out of the use or inability to use the software or the information
contained herein.

The information contained herein is subject to change without notice. Revisions may be issued
from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system,
or published, in any form or in any way, electronically, mechanically, by print, photoprint,
microfilm or any other means without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE
®
 Colors displayed in the software application or in the user documentation may

not match PANTONE-identified standards. Consult current PANTONE Color Publications for
accurate color. PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. ©

Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to
distribute for use only in combination with Studio Visualizer. PANTONE Color Data and/or
Software shall not be copied onto another disk or into memory unless as part of the execution
of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org).
All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk
Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP
are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric
Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign,
PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries.
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Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the
United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are
registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark
Office.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered
trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BV

Kortrijksesteenweg 1095

B – 9051 Gent

info.eur@esko.com
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2.  Preface

2.1.  What is Curve Pilot

Curve Pilot is a software tool that calculates Dot Gain Compensation (DGC) curves from
measured data. Curve Pilot helps you correct the dot gain characteristics of your system
towards desired printing targets through the adaptation of intensities used during the RIP
phase and the plate-making process.

Curve Pilot provides:

• A DGC Curve Editor for calculating single dot gain compensation curves from measured
data and (optionally) desired / reference dot gain targets.

• PressSync for calculating sets of ink-based dot gain compensation curves (PressSync
Curve Sets) from measured data and a variety of printing conditions based on industrial
specifications or ISO standards.

• A DGC Strategy Editor for combining single DGC curves and PressSync curve sets into
complete compensation strategies; using strategies enables you to assign multiple DGC
curves to the same ink / separation based on varying screening parameters.

2.2.  Installation
Curve Pilot is installed as part of the Imaging Engine Installation DVD. Please see the Imaging
Engine Installation Guide (located on your installation DVD) for details.

If you have a PressSync license, Curve Pilot is installed as two applications:

Application Name Icon Description

Curve Pilot All Basic and/or PRO functionality +
PressSync functionality

PressSync Pilot PressSync functionality only

Note:  You do not need to run PressSync Pilot separately. With a PressSync license, you can
access all PressSync functionality from within the Curve Pilot user interface.

2.3.  Data Types
Curve Pilot works with the following types of data files:
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File Type Description

.dgc A .dgc file contains measured data, calculated data, and optionally
reference (target) dot gain data for a single DGC curve.

.prsync A .prsync file contains measured data, calculated data, and reference
(target) dot gain data for multiple DGC curves; each DGC curve
corresponds to a specific ink/separation.

.icpro An .icpro file combines multiple DGC curves (saved in multiple .dgc
files) into a DGC strategy.

.scrdgc (legacy) A .scrdgc file combines multiple DGC curves (saved in multiple .dgc
files) into a screen-based DGC strategy.

Note:  Curve Pilot can only read existing .scrdgc files. A .scrdgc file is
converted to .icpro upon import. See also Migration Tool for SCRDGC Files
on page 115.

2.4.  How to Read this Guide

This guide assumes no prior experience in calculating dot gain compensation (DGC) curves or
setting up DGC-related workflows.

If you are not familiar with the concepts of dot gain, dot gain compensation, and press
fingerprinting, you are encouraged to read the relevant sections on What is Dot Gain? on page
10 and Dot Gain Compensation on page 14, the topics under Press Fingerprinting on page
18, and also the concepts behind What is a Strategy? on page 32 first.

If you are an experienced pre-press or press professional, you can safely skip this introductory
material and start at Press Fingerprinting with Curve Pilot on page 19, to learn more about the
distinct Curve Pilot and PressSync Pilot features.

If you want to generate DGC curves manually, read Working with DGC Curves on page 20;
start with The Curve Pilot Editor on page 20, then move on to Advanced Curve Editing on page
26.

If you are a pre-press manager seeking an integrated process for managing the DGC needs of
your print setup based on printing standards or specifications, read Working with PressSync on
page 39. PressSync functionality can be studied independently without prior knowledge of
using the Curve Pilot DGC curve editor.

PressSync presents a systematic way of calculating ink-based curve sets conforming to a
variety of printing standards; to leverage the full potential of PressSync, a better understanding
of What is PressSync? on page 39, Automated Measurements on page 55, PressSync
Templates Based on the ISO 12647 Standards on page 110, PressSync Templates Based on the G7
Calibration Method on page 113, and possibly Gray Balance in CMYK Templates on page 67,
Gray Balance Calculations on page 68 and Gray Balance Feather-Off on page 69 will be
required.

To devise combined ink-based and screen-based DGC strategies, read Working with DGC
Strategies on page 32.
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To understand the effect of applying multiple DGC curves on the same job, study the material
on The Preview Combined Curves Tool on page 94.

This guide is complemented with a number of Appendices on page 99 providing mostly
reference information on various features of the software. Depending on your level of
knowledge and expertise, you may want to refer to these topics selectively on a need basis.

2.4.1.  Conventions

A number of typographic conventions are used throughout this guide:

Example Description

Dot gain Terms introduced for the first time, terminology, important
keywords may be displayed in bold for emphasis

Save As... Menu items, window / dialog titles, user-interface
elements are always displayed in bold

User Defined User input is displayed in a monospace (typewriter) font

[0..100] Numerical ranges are enclosed in brackets []

<InkName> Variable content is enclosed in angle brackets <>

"C|M|Y|K" Mutually exclusive values are separated by |

\\server\bg_data_dgc_v010\ Application folders and directory paths are always
displayed in a monospace (typewriter) font

9
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3.  What is Dot Gain?
Most printing processes convert high-level vector digital information (such as a PDF or PS file)
into high-resolution raster or bitmap images, also known as digital films, one for each printing
ink. A Raster Image Processing (RIP) application creates digital films with a resolution
(expressed in ppi) that is supported by the imaging device.

 

 

For every printing ink, the RIP application puts a raster of pixels at the resolution of the imaging
device on top of the original design. To take into account the intensity of the object, the
screening raster is added. For every pixel of the object that is lying in a dot of the screen, the
pixel is set to black in the final digital film (for a positive film).

 

 

The distance between the dots in this screening raster is expressed in lpi (lines per inch), lpcm
(lines per cm) or lpmm (lines per mm). This is called the screen ruling.
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After the ripping phase, films and/or plates are created and put on the press. The file is printed
and... is (much) darker than the original file in the desktop program.

The reason for this will be no surprise to most people: dots on the press always print fatter
than the original dots on the film or plate, they increase in size. This phenomenon is known as
Dot Gain.

Take a look at an example design:

Original image

 

 

Printed result

 

 

Take a closer look and observe the differences in between the design, the digital film, and the
final print result:
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On microscopic level, dot gain would look like this:

 

 

3.1.  Sources of Dot Gain
The amount and type of dot gain are influenced by different factors. Especially the type of
press (offset, flexo, gravure...), the type of substrate (coated paper, uncoated paper....) and the
type of ink have a large influence on the dot gain.

Four different sources of manufacturing dot gain can be distinguished:

1. Plate making dot gain

In the case of an offset process, the image on the film is transferred photographically to
the plate. This is typically done by exposing a pre-sensitized plate, masked by the film, to
intense UV-light. For several reasons, the image is always slightly overexposed. This causes
a 50 percent screen dot to result in a 45% dot on the plate, if a positive masking film is used,
and a 55% dot if a negative film is used.

In the case of a flexo-process, exposing the negative film in the copy frame also results
in dots on the plate that are significantly bigger than the white dots on the negative film,
sometimes even 10%.
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In case of direct-to-plate imaging, there is no copy phase from film to plate. As a result,
plate-making dot gain or dot loss is completely avoided. Possible fluctuations in dot gain
during plate-making are avoided as well. This is one of the main advantages of direct-to-
plate technology. However, plate-making through a direct-to-plate process has a different
dot gain behavior than plate-making for which a frame copy from film is used.

Plate making dot gain is difficult to control because several factors are involved: longer or
shorter exposure times, the nature of the light source, the film and the plate.

2. Printing-pressure of the ink

On the press, due to the pressure (flexo!) and to the fact that the ink is fluid, a 50 % dot on
the plate will cover a paper area equivalent to a 60 % dot.

3. Paper type

The surface roughness and porosity of the paper cause internal light reflections around
the ink boundaries, making the border areas look darker. On smooth coated paper, a 50 %
covered area will perhaps only reflect 40 % of the incident light, resulting in an apparent 60
% dot. On uncoated paper it would look even darker.

4. Type of press

There are different printing methods (flexo, offset, gravure...), so it is logical that there are
also a lot of variations in the dot gain.

a. Offset Printing

For a typical offset press, with a positive film to plate, and a 50% dot on film:

• The plate-making will lose 5%
• The press will add 10% (dependent on the pressure)
• Coated paper reflections will add another 12%

Which will give a final result of 67%, or 17% apparent dot gain.
b. Flexographic Printing

We have already explained that the printing pressure of the ink has a huge influence on
the amount of dot gain: the more pressure, the more dot gain. That is why, generally,
flexo presses have higher dot gain values, for example:

Film Print

40% 78%

80% 98%

c. Gravure Printing

Gravure presses are characterized by a type of dot gain that is similar to that of
offset presses for small dot sizes (up to circa 30%), but sharply increasing at higher
percentages. Solid areas are printed with an effective cylinder dot area of 60 to 70%.
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4.  Dot Gain Compensation
For many print buyers dot gain has an unexpected and above all unwanted quality effect on
the prints:

• Because of the increase in the printed dot, the general aspect will be too dark.
• Dot gain in screened densities also causes huge changes in hue and saturation.

Another example: a color made up of 100% cyan and 50% magenta will suffer from dot gain
in the magenta, but not in the cyan. The color will be too dark but also too red.

Print buyers want predictable and correct printed results that are up to a standard or
correspond to the contract proof. That is why Dot Gain Compensation (DGC) is definitely
needed.

The basic principle of dot gain compensation is very simple. Take a look at the following
picture:

 

 

This picture explains that, in order to obtain a dot of the right size in print, a smaller dot has
to be put on the digital film. In other words, applying dot gain compensation means that the
original dot is compensated (usually reduced) to a certain extent on the digital film.

4.1.  Dot Gain Compensation Curves

We can compute dot gain curves by relating tone values (intensities) in the input to tone values
in the output. In the sample dot gain curve below, we can see that a tone value of 20% in the
input (digital film) measures 57% in the output (printed result), while a tone value of 50% in the
input measures 85% in the output.
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If we want to print linearly, i.e. eliminate all dot gain in the output, then we need to apply a dot
gain compensation curve that is the "mirror image" of the dot gain curve for our process. This
curve is shown below next to the dot gain curve for contrast.
 

 
We can easily tell that data points on the dot gain compensation curve have been inverted: a
tone value of 57% in the input becomes 20% in the output, while a tone value of 85% in the
input becomes 50% in the output.

The combined effect of both curves on our print job is full dot gain compensation
(linearization). This is clearly shown in the third graph (green line) below.
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This is the principle applied during ripping and printing. Prior to screening, all intensity
values are pulled down by the dot gain compensation curve (blue), leading to smaller dots
on the digital film. The press "adds" its usual dot gain (red), resulting in intensity values that
correspond to the original design.

 

 

However, eliminating all dot gain from a print job is not always desirable. This is explained
further in How Much Dot Gain Compensation to Apply on page 16.

4.2.  How Much Dot Gain Compensation to Apply

Let us take another look at our example design, and compare the printed results with no dot
gain compensation and full dot gain compensation (linearization) below.

Original image
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Printed result with no dot
gain compensation

 

 

Printed result with full
dot gain compensation
(linearized)

 

 

Take a good look at the picture above, and ask yourself the following question: "Am I happy
with this result?" The answer will probably be "No", because the printed result is too light. The
human eye is used to expect a certain amount of dot gain in printouts, and the amount of dot
gain present in print jobs has historically grown. The standard offset dot gain (50% prints as
68.5%) has always been considered visually acceptable.

Full dot gain compensation (in other words, linearization) clearly produces prints that are too
light. In order to obtain a visually pleasing print result, a certain amount of dot gain must be
retained in the final printout. This amount is specified in a target. The target defines a desired,
or reference, printing condition.

Matching a target involves tuning / syncing the printing process so that the amount of dot
gain present in the final print follows the amount of dot gain specified in the target within
acceptable margins. Very often standard offset dot gain is used as the target (or reference
condition) to match.
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5.  Press Fingerprinting

5.1.  What is Press Fingerprinting

The process to determine how a press prints and to quantify dot gain values is commonly
known as press fingerprinting. Following a fingerprint run, a dot gain compensation (DGC)
curve or curve set (for different inks) is created, so that the printed tone values can match a
standard.

Fingerprinting is an essential validation step of the prepress and press settings. Without
fingerprinting, the task of printing to a desired printing condition or standard becomes
increasingly difficult.

Fingerprinting does not replace, and should not be confused with, routine preventative
maintenance. In fact, a press should be in top operating condition prior to the fingerprinting
process, so that fingerprinting results (measured densities, DGC curves, etc.) can be
reproducible and reliable.

Production jobs may contain control strips that are measured manually or automatically to
check print consistency. If the control strips are consistently measuring the same but not
within the desired print condition or standard tolerance, the DGC curve(set) for the press will
have to be adjusted.

Press fingerprinting depends on most operating parameters and will have to be repeated
if there is a change to these parameters, including substrate type, ink, plate, run speed,
screening (dot shapes, ruling, screen angles), and even operator experience / skill level. In
general, there should be a DGC curve(set) for each set of operating parameters commonly
employed with a specific press.

5.2.  How to Fingerprint a Press

To fingerprint your press for a given set of operating conditions and match its performance to
a desired printing condition or standard, you generally have to:

1. Create test jobs that contain patches with different tones, e.g.: 1%, 2%, 3%, 4%, 5%, 10%,
20% ... 80%, 90%, 95%, 100%. The picture below shows a typical control strip of CMY-
generated gray tones and CMY-solid.
 

 
2. Rip the test job(s) using the procedures outlined in your Imaging Engine or equivalent RIP

application manual.
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3. If applicable to your printing application, expose the film/plate. Make sure that the normal
workflow is applied and that the image-setter is calibrated correctly: 50% in the job must
measure 50% on the film, or the black mask in case of a CDI®. Small deviations (up to 1%)
are acceptable.

4. Print the test job(s) using a well-defined set op operating conditions (substrate, inks, press
speed, screening parameters, etc.)

5. Measure the printed patches.
6. Compare the dot gain present in the print(s) with the reference dot gain set in your desired

printing conditions or standards.
7. Adjust the dot gain compensation curves used in your print job(s) if necessary.

5.3.  Press Fingerprinting with Curve Pilot

With Curve Pilot, you can fingerprint your press in two distinct ways: (a) using the Curve Pilot
dot gain compensation editor for single dot gain compensation (DGC) curves, or, (b) using
PressSync functionality to calculate ink-based curve sets from desired printing conditions and/
or standards.

If you wish to create DGC curves one by one manually, you can use the Curve Pilot DGC curve
editor. You will have to measure control strips from production runs manually, and import
your measured data into the application as text files or type them in manually. For each DGC
curve to calculate, you will have to select the desired printing target (reference dot gain curve)
manually. You will be able to combine individual DGC curves into strategies, but you will have to
calculate and save each DGC curve separately before you can generate a strategy.

With PressSync, your workflow will be significantly simplified. You will be able to create and
save a dot gain compensation curve set for all process / spot inks present in your job at once.
You will typically select a template for your curve set first, based on a number of desired
printing conditions extracted from printing specifications or industrial printing standards.
You will then measure sample jobs either manually or automatically. Curve Pilot / PressSync
Pilot will calculate the best fitting dot gain curve set for matching your preferred standard(s)
automatically.

You can also combine using PressSync with the Curve Pilot editor. For example, you can always
export a DGC curve from a PressSync curve set into the Curve Pilot editor and refine it further
manually.

19



6 Curve Pilot

6.  Working with DGC Curves

6.1.  The Curve Pilot Editor
The Curve Pilot editor lets you create and modify single dot gain compensation (DGC) curves
from measured data and an optional desired (reference) dot gain curve.

Advanced curve editing features include the ability to import precalculated DGC curves, and
to customize the shape of calculated DGC curves in a variety of ways. For the details, see
Advanced Curve Editing on page 26.

6.1.1.  Create a DGC Curve

To create a new dot gain compensation (DGC) curve, you need to enter measured data first.
Select New > DGC (.dgc) from the main File menu.
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Add your measured data in New Point: you can use the Tab key to quickly switch from Film%
to Print% input data. Hitting Enter after you have entered a Print% value takes you back to the
Film% input box.

Follow this procedure to enter sample [Film%,Print%] data, e.g. [10%,15%], [30%,40%],
[50%,62%], [70%,80%], [90%,95%].

Note:

If you want to enter density print data instead of % values:

• Select Edit > Preferences... on the Curve Pilot main menu and change the DGC
Densitometer measures: setting from Percentages to Densities.

• Enter the maximum density of your measurements in the Maximum Density input text
box.

Note that the maximum density in certain flexo applications is not necessarily the density of
the solid (100%) patch.

Curve Pilot will convert your density values into percentages using the Murray-Davies
equation.

6.1.2.  Save a DGC Curve

When you are done entering measured data, select File > Save As... on the Curve Pilot main
menu. Enter the desired name for your file without specifying a file extension and click OK.
A .dgc file will be saved under the folder shown in the main window title of your Curve Pilot
application. See also Location of Data Files on page 99 in the Appendix.

At this point you have not specified a desired (reference) dot gain curve. The saved .dgc file
contains your measurements and a dot gain compensation (DGC) curve calculated from your
measured data so that full dot gain compensation (linearization) is achieved in the final print
result.

6.1.3.  Import Measured Points from Text File

As an easier alternative to entering data points into Curve Pilot manually, you can import
measured data from a data file.

To import your data, select File > Import Measured Points from Text File.

Data points in the file should be in a simple two-column, tab-delimited format as shown below:

0 0
10 15
20 25
… ... 
70 80
90 95
100 100
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The data file name can have any extension, but the file itself must be saved as a simple text
file.

6.1.4.  Preview a DGC Curve

Make sure that Compensation curve under Show Curves is selected. Select Dot gain curve
as well. You will see two curves on your graph. The red curve is your dot gain curve from the
measurements you have entered. The blue curve is your dot gain compensation (DGC) curve.
Curve Pilot has calculated the best DGC curve possible to achieve full dot gain compensation
(linearization) in your print result.

 

 

You can verify this by selecting Print simulation under Show Curves. The purple line is the
expected dot gain curve in your final print result. It is a straight line indicating no dot gain in
your print result.
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6.1.5.  Edit Measured & Calculated Data

You can edit dot gain data points (measured) and dot gain compensation data points
(calculated) by dragging them on the curve with the mouse.

To delete a data point, select the point and click Ctrl + D.

Finally, to add a data point, click on the desired location of the graph where you wish to add
the new data point.

Note:  Whenever you edit measurements graphically, the dot gain compensation curve is
recalculated to continuously match your desired dot gain curve (target).

6.1.6.  Select a Desired Dot Gain Curve

You can select a different (non-linear) dot gain curve as your printing reference (target). Make
sure that Desired curve is selected, and pick the desired (reference) dot gain curve from the
Desired Curvelist.
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The green curve added to the graph is the desired (reference) dot gain curve. Notice how the
blue compensation curve has been recalculated automatically. It now adds dot gain to the
input (measured) data to match the desired target.

Select Print simulation to verify that the estimated dot gain in the final print result (purple
curve) closely matches the desired dot gain (green curve). In fact the two curves practically
overlap.

 

 

Saving your .dgc file saves the measured data, the calculated compensation curve, and the
desired (reference) curve all in the same file.

6.1.7.  Create a Desired Dot Gain Curve

You can create desired curves in addition to the ones provided with your Curve Pilot
installation. To do this, simply enter your data and save them under a unique name (i.e.
testdgc). Save your data again under a different name (i.e. testdgc-ref), but this time make
sure that you select Save as desired (reference) curve in the Save DGC dialog. Curve Pilot will
create the new reference curve as read-only and will automatically close your editor window
after that.

Note:  You cannot load a desired curve directly from the File > Open... menu item of the Curve
Pilot main menu.

6.1.8.  Edit a Desired Dot Gain Curve

Curve Pilot saves all desired (reference) dot gain curves under \\server
\bg_data_dgc_v010\refdgc, where server is the central location of automation data.

You cannot load .dgc files located in the refdgc subfolder directly into Curve Pilot. As a result,
you cannot edit desired (reference) curves directly.
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To overcome this limitation, copy the desired (reference) curve in the bg_data_dgc_v010
folder, edit the curve as usual, save it, and move it back in the refdgc subfolder.

6.1.9.  Swap Measured Points

To swap the columns of the measured points, select Edit > Swap Measured Points from the
Curve Pilot main menu.

This action results in the inverted compensation curve. The inverted compensation curve can
be used to "undo" the compensation on pre-compensated images for proofing.
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6.2.  Advanced Curve Editing

6.2.1.  Import Tone Curve Exchange Data (ISO 18620)

Curve Pilot supports importing Tone curve Exchange Data (ISO 18620) from a file.

To import your data, select File > Import Tone curve Exchange Data (TED). You can only
import well-formed files with the extension .ted. Importing an improperly formatted .ted file
may crash the application without warning.

A .ted file can contain any number of tone curves. The curve(s) imported from a .ted file are
always interpreted by Curve Pilot as dot gain compensation curves, not measured data.

Curve Pilot generates an .icpro strategy in memory from the imported curves, and saves
all .dgc files present in the strategy in the central location of DGC data. You need to save the
.icpro strategy separately.
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For more information on .ted files and their conversion into .icpro strategies, see Tone Curve
Exchange Data (TED) Files on page 109.

6.2.2.  Smooth Curve

You can influence the way a dot gain compensation (DGC) curve is calculated by changing the
Smoothing Margin parameter value. The default value is 3 and the default permissible value
range is [0..10].

For more aggressive smoothing, select Optimize curve. The permissible value range becomes
[0..20]. A higher value indicates a smoother curve.

 

 

6.2.3.  Minimum and Maximum Values

Setting the Minimum Value and Maximum Value parameters refines the shape of a dot gain
compensation curve in the highlights and in the shadows respectively. This may be desirable in
certain applications of flexography.

With a non-zero Minimum Value, the first non-zero tone / intensity in the job is corrected /
compensated at the Minimum Value. The Minimum Value setting does not affect the 0% tone,
which remains at 0% and is never screened.

With a Maximum Value smaller than 100, the 100% (solids) tone /intensity in the job is
corrected / compensated at the Maximum Value. A Maximum Value setting smaller than 100
implies that the 100% (solids) tone will be screened.

You can examine the effect of these parameters on your DGC / print simulation curves and in
the Compensation Values Table.
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6.2.4.  Keep 0% to: Parameter

There may be small intensity values in your job that you can safely discard as digital noise.
Equivalently, there may be small dot % values on your uncompensated film/plate that you
want to disregard as dust.

You can do this by setting the Keep 0% to: parameter to a small value, typically 0.4% or
lower. Curve Pilot will treat all input below that value as zero and will set the corresponding
corrected / compensated values to zero.
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6.2.5.  Keep 100% Parameter

The Keep 100% option instructs Curve Pilot to not apply a correction / compensation value for
the 100% tone in the job. As a result, solids are not screened.

If you don't select Keep 100%, the 100% tone will be corrected / compensated to the value set
in Maximum Value (if that value is less than 100%).
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Note:

You can also apply curves that use the Keep 100% option on jobs using a surface screening
effect (a pattern used in the solids to improve ink lay-down). In this case:

• If you select Keep 100% in the curve, the 100% areas of the job will be screened with the
surface screening effect.

• If you don't select Keep 100%, the 100% areas will be screened at your Maximum Value
percentage. The surface screening effect will not be used.

6.2.6.  Bump Highlights

You can further modify the shape of the DGC curve in the highlights. To do this:

1. Select Optimize curve
2. Select Bump highlights
3. Enter a value for the Slope parameter
4. Enter a value for the Range parameter

If you want to influence the shape of the DGC curve over a wider range of input values, select a
large value for the Range parameter:
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To radically change the shape of the DGC curve in the highlights, select a large value for the
Slope parameter:

 

 

Curve Pilot lets you change the slope (and range) by dragging the slope end point with your
mouse.

6.2.7.  Fit PressSync Curve

While we have not discussed PressSync compensation curves yet, it is worth mentioning at this
point that you can fit a PressSync dot gain compensation curve to the DGC curve calculated by
Curve Pilot. To do this, select PressSync curve under Show Curves.
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The best-fitting PressSync curve is displayed in red next to the PressSync curve check box. The
curve is displayed dotted in red.

You can influence the Curve fit by switching between Standard and Robust. For the
differences between these two settings, see Curve Fitting Options on page 108.

You can also select Flexible to use a flexible PressSync curve, that allows fine-tuning of
the highlights and shadows. See What is a Flexible PressSync Curve? on page 42 for more
information.

6.3.  Working with DGC Strategies

6.3.1.  What is a Strategy?

Dot gain within the same print job can vary depending on the screening parameters, inks, and
other factors.

A dot gain compensation strategy allows you to use different DGC curves on different areas
of the film or plate, taking into account different inks (separations), screening parameters, and
compensation requirements for continuous tone images (CT) vs. line work (LW).
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A complete DGC strategy provides a compensation curve for every practical combination of
inks, screens, and/or any other operating parameters affecting dot gain used on your press,
and links the right compensation curve to each applicable set of operating conditions.

Note:

Curve Pilot saves DGC strategies in the .icpro file format.

If you are familiar with former versions of Curve Pilot, you have already created screen-based
strategies in the .scrdgc file format. It is not possible to create .scrdgc files any more, but
you can still use them by importing them (File > Import > SCRDGC).

It is also possible to migrate .scrdgc files in one go with the Migration Tool. For more
information on this topic, see Migration Tool for SCRDGC Files on page 115.

You do not need a separate DGC strategy for each new print job. Well-designed strategies
are applicable to many jobs as long as the printing circumstances / operating conditions are
similar.

In many cases one strategy per press and per resolution of the image setter is sufficient, and
most prepress operators require no more than 10-30 strategies in total.

Simple Ink-Based Strategies
You can employ simple ink-based strategies when you are primarily interested in
compensating dot gain on different separations/inks differently.

In practice this is often the case with yellow, where dot gain compensation is much less
needed, and with black, where for example softer flexo plates may require different bump-up
settings in the highlights.

But you can also employ more complex strategies to distinguish between parts of the job
based on dot shapes, screen rulings and angles, or the presence of contones (CT) and linework
(LW). These are combined ink- and screen-based strategies.

Combined Ink- and Screen-Based Strategies
You can use combined ink- and screen-based strategies to apply specialized dot gain
compensation curves to parts of your job based on additional screening parameters. The
screening parameters that you can use to specialize your strategy, and a few representative
use cases, are shown in the Table below.

Screening
Parameter

Use Case(s)

Dot Shape Apply different DGC curves to different parts of your job requiring different
dotshapes (square, round, elliptic, etc.) Apply different DGC curves to
stochastic screens (e.g. Monet), which are known to produce more dot gain
in the midtones than conventional screens.

Screen Ruling Apply more aggressive DGC curves to higher rulings (keeping in mind
that dot gain occurs on the perimeter of printed dots, and double ruling
practically doubles dot gain).

CT or LW Do not apply DGC curves to contones, if they have already been
compensated during an image retouching step.
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Screening
Parameter

Use Case(s)

Extra Info:

• In some cases, bump-ups are not needed for contones because contone
highlights have been cleaned out with an editor.

• Contones and line work may also require a different approach
with respect to smoothness versus precision. In spite of identical
measurement values, it is possible that contones will be compensated
with a different smoothing setting.

• Other constraints may be set differently for contones and for line work.
For example, Keep 100% is usually turned on for line work but turned off
for contones.

• Groovy screens may require different treatment of contones and line
work as well; for the details see the Groovy Screens manual.

6.3.2.  Creating a Strategy

To create a new strategy, select File > New > Strategy (.icpro) from the main Curve Pilot menu.
In the strategy editing dialog that comes up, you can create a rule-based (decision) tree by
inserting nodes for different inks, dot shapes, screen rulings, screen angles, and contone/
linework. Select File > Save As... to save your strategy with a desired name.

Type of Action Click Function Notes

Add ink rule Add any number of inks from any
ink book known to the system
that require a separate DGC
curve.

This action generates an Other
Inks node by default, if one is
not already present at the same
level.

Add process
inks rules

Use as a shortcut for adding
C,M,Y,K ink branches to the tree.

This action generates an Other
Inks node by default, if one is
not already present at the same
level.

Note:  Use the Other Inks node
to group all inks requiring the
same DGC curves.

Add dotshape
rule

Add any number of dot shapes
that require a separate DGC
curve from the list.

This action generates an Other
Dotshapes node by default, if
one is not already present at the
same level.

Add screen
ruling

Add any number of screen
rulings (lpi) that require separate
DGC curves.

The default lpi for a new node
is 100. Double click on it to edit
the value. Permissible values are
[10..10000] lines per inch.

34



6Curve Pilot

Type of Action Click Function Notes

Add screen
angle

Add any number of screen
angles that require separate DGC
curves.

The default angle for a new node
is 7.5. Double click on it to edit
the value. Permissible values are
[0..180] degrees.

Add images /
linework rule

Add different DGC curves for
contones (images) and linework.

This action generates a CT and a
LW node by default.

Delete node Delete the selected node. This action may delete all nodes
below the currently selected one.

For each new rule / node in the tree, the default DGC curve is set to <none>, implying no
compensation. Click on <none> to select a different compensation curve from the list.

The order of adding / deleting nodes in the tree is not important, but a few ground rules apply:

1. All top level nodes must be of the same type.
2. All subsequent level nodes under the same parent node must be of the same type.
3. Deleting a node may automatically delete its children to ensure that rules (1) and/or (2) still

apply.
4. A new node is added:

a. At the same level with the currently selected node, when both nodes are of the same
type.

b. Below the currently selected node, when the new node and the children of the currently
selected node are of the same type.

c. Above the currently selected node, when the new node and the parent of the currently
selected node are of the same type.

With these simple rules in mind you can create complex strategies for your particular
operational needs. The picture below shows a strategy treating black and other inks differently,
and making use of stochastic and classic screening with various lpi's in the case of classic
screening.
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6.3.3.  DGC Strategies and PressSync Curve Sets

Curve Pilot lets you use PressSync curve sets within strategies. This way you do not need to
create ink-based strategy rules one by one.

To use an existing PressSync curve set within a strategy rule, make sure that you select  as
the curve type for your strategy rule first.

You can find an example of a strategy built from PressSync curve sets below:
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In the highlighted strategy rule, a PressSync curve set is used, avoiding the need to create
separate rules for each process color.

6.3.4.  How the RIP Retrieves the Right DGC Curve

It is important to understand how a RIP application interprets an .icpro strategy.

Your job contains objects characterized by a set of attributes: CT/LW, separation, dot shape,
ruling (lpi), screen angle. Depending on your editing application, these may be set on a job-
wide basis, or on an object-specific basis. Either way, the RIP application goes over all objects in
your job and determines the best matching compensation curve in the strategy for each object
present in the job.

The strategy shown below distinguishes between black and other separations, then
distinguishes again between stochastic (Monet/FM) and classic (AM) dot shapes. The strategy
defines different DGC curves for different rulings (lpi values) in the case of classic dot shapes.
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When the RIP application encounters a cyan object, it searches for additional object attributes
under 'Other Inks'. If the object's dot shape attribute is set to 'Monet', no DGC curve is applied
in rasterizing the object; if the object's dot shape attribute value is 'Circular (Euclidean)', the
best matching DGC curve is selected based on ruling (lpi).

If the object's ruling attribute is set to a value other than the exact ones specified in the
strategy (that is, one of 85/100/120/133/150), then the closer lpi value determines the DGC
curve to use in rasterizing the object. In our particular example, an object with lpi set to 110 is
processed with cdi_lin_100.dgc, as lpi=100 is the closest lpi value specified in the strategy.

To preview which DGC curve is applied on parts of your job based on context (CT/LW,
separation, dot shape, ruling, screen angle), you can use the Preview Combined Curves tool in
Curve Pilot.
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7.  Working with PressSync

7.1.  What is PressSync?

7.1.1.  What is a PressSync Curve?

Curve Pilot / PressSync Pilot comes bundled with 400 PressSync curves. Those are pre-
defined dot gain compensation curves of various forms and shapes that can fit the dot gain
compensation needs of most presses.

Using PressSync curves significantly reduces the complexity of dot gain compensation in
workflows.

PressSync Curve Names
PressSync compensation curves are defined by a letter (A to H) and a number (20 to 70): A40,
D20, F30, etc. The letter indicates the general shape of the curve in the highlights and in the
shadows. The number indicates the compensation value for the 50% dot (midtone).

20 50 70

A

E
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20 50 70

H

PressSync Example Curves
The A50 curve increases dot gain in the highlights (forcing the press to print darker in the
highlights), and reduces dot gain in the shadows (thus forcing the press to print lighter in the
shadows). The H50 curve exhibits the opposite behavior. Both curves exhibit an inflection point
(where their slope changes sign) in the midtone.

 

 

The E70 curve increases dot gain throughout the tonal range, correcting the midtone to 70%.
The E20 curve decreases dot gain throughout the tonal range, forcing the midtone to 20%.
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Minimum and Maximum Values
A PressSync curve can also contain information about a minimum and a maximum value.

The minimum value is the correction / compensation for the first non-zero tone. For example,
if the minimum is set at 6%, the first tone value after zero will be adjusted to 6% as shown
below.

 

 

Note:  Regardless of the minimum value you choose, the 0% tone remains at 0%. As a result,
the 0% tone will not be screened.

The maximum value is the correction / compensation for the tone just below 100%. For
example, if the maximum value is 96%, a tone of 99.5% for example will be corrected to 96%
and screened as shown below.
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Note:

The 100% tone (the solids) will use the 100% level of the screen. This means that:

• for screens that do no use surface screening, solids will be kept as solids (not screened),
• for screens that use surface screening, solids will use the surface screening pattern defined

for 100% in the screen.

Tip:

If you want to use your maximum value to screen the solids (so 100% is screened at 96% for
example), you should:

• use a flexible PressSync Curve,

• set the Maximum Value you want to use for screened your 100% tones,

• deselect the Keep 100% option in your curve.

7.1.2.  What is a Flexible PressSync Curve?

A flexible PressSync curve is a specific type of PressSync curve made for managing the tone
reproduction of flexo printing environments.

Note:  To work with flexible PressSync curves, you need to enable this feature in the
Preferences: go to Edit > Preferences... and select Enabled next to Flexible PressSync.

On top of the letter and number defining the standard PressSync curves, flexible PressSync
curves contain options to address specific flexo printing challenges.

Reproducing Highlights
Flexo highlights are often too sharp against the substrate and/or unstable, which can be
difficult to adjust using standard PressSync curves:

• For some ink/substrate combinations, the contrast between the substrate and the lightest
printed tone is high: even a very small halftone dot leaves a strong ink impression.

• On top of that, very small dots often don't print in a stable way on flexible substrates, so the
minimum dot size is increased to get stable highlights.

Flexible PressSync curves contain parameters to address those highlight issues. See Highlights
Parameters on page 43.

Reproducing Shadows
The most common issue with shadows in flexo is tone reversal, where a high percentage (for
example 95%) prints darker than the solid (100%).

Surface screening effects (special screen patterns used in the solid areas to improve ink
lay-down and avoid tone reversal) are often used in offset, but not always available for, or
compatible with, a flexo printing environment.

Flexible PressSync curves also contain parameters to address tone reversal issues in the
shadows. See Shadows Parameters on page 45.
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Highlights Parameters
To address typical flexo highlight issues, you can use the following parameters in your Flexible
PressSync curves:

Minimum Value
Enter the minimum tone that you want to print.

For example, if you noticed that your press only prints in a stable way from 3%, you can set
your minimum dot (the first percentage after 0%) to print at 3%, and gradually increase the
tones from there.

 

 

Keep 0% to
Choose the highlights level you don't want to print.

For example, if the tones up to 0.8% print in a very unstable way, you can choose to turn those
into 0% so they won't be printed.

Note:

You can combine the Keep 0% to and Minimum Value options. If for example you want to
drop all percentages below 0.8%, and have your minimum printed tone be 3%, then:

• input percentages between 0% and 0.8% will not be printed,
• input percentages above 0.8% will be printed starting from an output percentage of 3%.
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Attention:

• If you want to apply these options to curves that you will use in Imaging Engine,
make sure that you:

• apply the Keep 0% to option to the press curve,

• apply the Minimum Value option to the plate curve.

If you apply these options differently, your output could be unpredictable!

• If you are working with a single curve (for example in a printing condition from the
Print Control Wizard), you can apply both Keep 0% to and Minimum Value options
to this curve.

Highlight Shape
Add a specific highlights correction, to either increase or reduce dot gain in the highlights.

You can choose how much correction to apply, and over how much of the highlights, by setting
the Slope and the Range of the correction.

• The Slope defines whether the correction increases or decreases the printed tone, and by
how much.

You can set a slope of 1 to 9: 1 is the maximum tone decrease and 9 the maximum tone
increase.

 

 

 

 

• The Range is the magnitude of the correction (over how much of the highlights it is applied):
1 is the smallest range and 9 the biggest (up to the mid-tones).
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Tip:

When working with a flexible PressSync curve, use the Slope and Range sliders to define your
highlights correction, and you will see the correction factor in the Highlight Shape field.

 

 

For example, for a slope of 1 and a range of 3, the Highlight Shape will show 31 (the first digit
being the range and the second one the slope).

Shadows Parameters
To address the shadows' tone reversal issues in flexo printing, you can use the following
parameters in your Flexible PressSync curves:

Maximum Value
Enter the maximum non-solid tone that you want to print.

For example, if you noticed that 95% gives you the highest density, you can choose to print
your shadows with a maximum of 95% instead of 100% (percentages between 95% and 100%
will be recalculated to have a maximum of 95%).
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Keep 100%
Choose whether solids should be printed as solids (100%), or as your maximum non-solid tone
(Maximum Value).

• If you are using a Maximum Value but are not keeping the solid tones to 100%, your solids
will be screened to your maximum value (for example 95%).
 

 
• If you are both using a Maximum Value and keeping the solid tones to 100%, your

shadows (up to the last tone before the solid, for example 99.9%) will be reproduced using
your maximum non-solid tone (for example 95%) as maximum, but your solids will stay
solid and unscreened.
 

 

Shadow Shape
Add a specific shadows correction, to either increase or reduce dot gain in the shadows.

You can choose how much correction to apply, and over how much of the shadows, by setting
the Slope and the Range of the correction.

• The Slope defines whether the correction increases or decreases the printed tone, and by
how much.

You can set a slope of 1 to 9: 1 is the maximum tone increase and 9 the maximum tone
decrease.
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• The Range is the magnitude of the correction (over how much of the shadows it is applied):
1 is the smallest range and 9 the biggest (down to the mid-tones).
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Tip:

When working with a flexible PressSync curve, use the Slope and Range sliders to define your
shadows correction, and you will see the correction factor in the Shadow Shape field.

 

 

For example, for a slope of 2 and a range of 1, the Shadow Shape will show 12 (the first digit
being the range and the second one the slope).

Flexible PressSync Curve Name
The name of a flexible PressSync curve reflects the parameters it contains. Parameters that are
not used are not part of the flexible PressSync curve name.

Example
The following flexible PressSync curve uses all possible parameters:

E 50 k0.8% min3.0% h31 max95.0% s12 k100

This notation... indicates... see also:

E 50 the letter and number of the standard
PressSync curve it is based on

PressSync Curve Names on page
39

k0.8% that the highlights between 0% and
0.8% are dropped

Keep 0% to on page 43

min3.0% a minimum printable value of 3% Minimum Value on page 43

h31 a highlight shape correction with a slope
of 1 and a range of 3

Highlight Shape on page 44

max95.0% a maximum non-solid tone of 95% Maximum Value on page 45

s12 a shadow shape correction with a slope
of 2 and a range of 1

Shadow Shape on page 46
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This notation... indicates... see also:

k100 that the solids are kept to 100% and
unscreened

Keep 100% on page 46

7.1.3.  What is a PressSync Curve Set?

A PressSync curve set is a collection of predefined dot gain compensation curves, each
attached to an ink (a process ink or a spot color defined in Esko's CMS database).

Curve Pilot / PressSync Pilot creates and saves PressSync curve sets in the .prsync file format.
A .prsync file contains information about the desired printing condition, measurement data,
the actual dot gain compensation curves, and history data related to curve set setup and/or
measurement actions.

When sending a print job to your RIP application, you typically associate one or more .prsync
files with it. This way, every separation in your job is compensated with the appropriate
PressSync curve. For the details please refer to your RIP application manual.

7.1.4.  What is a PressSync Template?

The easiest way to generate PressSync curve sets is to make use of predefined PressSync
templates available with your Curve Pilot application.

Every predefined PressSync template is linked to a desired printing condition, i.e. a color
profile (ICC or Esko) or Fogra characterization data set. The desired printing condition is used
to extract desired (target) Lab values for the solids, and desired dot gain curves defined in an
international printing standard or industrial specification.

The following types of PressSync templates are available:

• PressSync templates based on the ISO 12647 standards:

cmyk_Equinox.prsync
cmyk_Fogra51.prsync
cmyk_Fogra52.prsync
cmyk_ISO_Newsprint.prsync
cmyk_ISO_PT1&2 (NP).prsync
cmyk_ISO_PT1&2.prsync
cmyk_ISO_PT3.prsync
cmyk_ISO_PT4.prsync
cmyk_ISO_PT5.prsync

Those contain dot gain targets based on the ISO 12647-2 standard for offset printing. There
is a desired (target) dot gain curve for each process color (C,M,Y,K).

See PressSync Templates Based on the ISO 12647 Standards on page 110.
• PressSync templates based on the G7 calibration method:

3ck_Equinox.prsync
3ck_GRAColG7.prsync
3ck_SNAP.prsync
3ck_SWOP.prsync
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Those contain dot gain targets based on the GRACoL specification for commercial offset
lithography.

There is a desired (target) dot gain curve for CMY-composed gray (3c) and black (k). The
exact values are calculated using the G7 calibration method.

See PressSync Templates Based on the G7 Calibration Method on page 113.

• Linear dot gain templates:

cmyk_LinearColor.prsync
cmyk_LinearDensity.prsync

Those contain target curves for linear dot gain. They are not based on a specific standard
but will give good results in most cases (and a dot gain close to most standards).

See Linear Dot Gain PressSync Templates on page 114.

Working with Custom Templates
If you want to work with a custom PressSync template, see Customizing PressSync Templates on
page 75.

7.2.  Getting Started with PressSync
This section explains how to create your first PressSync curve set using a PressSync template
and automated measurements.

For other options and more in-depth explanations, please see Creating a PressSync Curve Set for
Your Press on page 52.

1. Select File > New > PressSync CurveSet (.prsync) from the Curve Pilot top menu.
2. In the Create New Curve Set dialog, select a PressSync template for your new curve set

from the selection list available for A standard.

See What is a PressSync Template? on page 49 for more information.

Note:

Never pick An empty curve set if you are planning to perform measurements and calculate
PressSync curves afterwards.

An empty curve set does not contain any desired printing conditions (targets) and it does
not support measurements. It is simply a collection of dot gain compensation curves from
the PressSync curve library.

3. Click Select Curve Names... in the main PressSync window.
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If you have printed your test job without any dot gain compensation, make sure that all
curves under Curve Name in the Select Curve Names dialog are Linear.

Otherwise, enter the PressSync curve(s) or flexible PressSync curve(s) used for printing.
4. Click Measure > Measure Automatic from the main menu.
5. In the Automatic Measurement dialog, select the chart type used in your print job from

the Layout selection list.
6. Reconnect your measuring device (if necessary), and click Start. Follow the instructions in

the dialog to complete your measurement. You may have to click Start several times.
7. If you want to keep a separate record of measurements only, click Save Measurement... to

export your measurement in the .it8 (CGATS) file format and save it in the desired location.
8. You can measure a test job multiple times. Click OK when you are done. Notice that each

measurement is listed separately under the Measurements tab.
 

 
9. Click on Go To Results to inspect your measurements against the desired (target) dot

gain values. A summary of the calculated dot gain compensation curves is included in the
rightmost Result panel under the Process Colors tab.
 

 
10.Click Save... and select Save curves to save measured data and calculated PressSync

curves, and to set the calculated PressSync curves as the active ones for printing
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subsequent test jobs. This way you do not need to repeat step (3) above before measuring
your next test job.

If you do not want to save / update the PressSync curves, select Save measurements only
instead.

11.Select File > Save As... from the top menu to save measurements and PressSync curves in a
different .prsync file under the central location of DGC data.

7.3.  Creating a PressSync Curve Set for Your Press
To compensate your press' dot gain using a set of PressSync curves, do the following:

1. Create a PressSync curve set indicating the curves you used for printing.

See Setting Up Your PressSync Curve Set on page 52.
2. Print a control strip or universal target and measure your press print out.

See Measuring with PressSync on page 54.
3. Curve Pilot calculates the correction your press needs based on your measurement results.

Review your results and save your PressSync curve set.

See Interpreting PressSync Results on page 60 and Saving PressSync Results on page 73.

You can also export your results, and view the results history.

You can now use your PressSync curve set when RIP'ing your files in Imaging Engine.

7.3.1.  Setting Up Your PressSync Curve Set

1. Select File > New > PressSync CurveSet (.prsync) from the Curve Pilot top menu.
2. In the Create New Curve Set dialog, select the template to use for your new curve set.

• In most cases, you should start from A standard PressSync template.

See What is a PressSync Template? on page 49 for more information about PressSync
templates.

• If you have previously created another PressSync curve set for similar printing conditions
and you want to use it as a starting point, select it in the An existing curve set list.

• If you are planning to perform measurements and calculate PressSync curves
afterwards, do not select An empty curve set.

An empty curve set does not contain any desired printing conditions (targets) and it does
not support measurements. It is simply a collection of dot gain compensation curves
from the PressSync curve library.

3. This opens the PressSync curve set editor, showing information  about the template you
selected.
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4. Click Select Curve Names... and select the curves you have used to print the test job that

you want to measure.

• If you have printed your test job without any dot gain compensation, select Linear for all
curves.

• If you used standard PressSync curve(s), select their letter and number, and the minimum
and maximum values you used (if applicable).

• If you used flexible PressSync curve(s), select their letter and number, and click the triangle
 to enter the flexible PressSync parameters you used.
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See Highlights Parameters on page 43 and Shadows Parameters on page 45 for
more information.

Your changes are reflected immediately in the graph at the bottom of the Select
Curve Names dialog, and you see the flexible PressSync curve name derived from the
parameters you enter.

5. When you are done setting the initial curves, you can start measuring your test job.

7.3.2.  Measuring with PressSync

To start performing measurements, click Measure... in the PressSync curve set editor.

In the Measure Curve Set dialog, you have the options to:

1. Measure a control strip automatically; select Automated measurements. This option is also
available from the main menu (Measure > Measure Automatic).

Curve Pilot understands a number of industry standard print chart layouts and you can even
define your own. See also Control Strips for Equinox on page 103.

2. Measure the universal target manually; select Universal Target. This option is also available
from the main menu (Measure > Measure Universal Target).

The universal target is a limited type of print chart containing a small number of patches.
Measuring the universal target can serve as a starting point for press fingerprinting.

3. Measure a control strip of a production sheet manually; select A control strip of a production
sheet. This option is also available from the main menu (Measure > Measure Control
Strip).

The control strip contains a limited number of patches and may not be sufficient for a
thorough investigation of the dot gain behavior of your system.

4. Resume an incomplete measurement session; select Your last (incomplete)
measurement. This option is also available from the main menu (Measure > Continue
Incomplete Measurement).

This option is not available if you have no incomplete measurements pending. You can
review your incomplete measurement actions under the History tab of the PressSync curve
set editor.
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If you have access to a supported spectrophotometer for automated measurements, using
Automated measurements is the preferred measurement method in Curve Pilot.

Automated Measurements
To perform automated measurements in Curve Pilot:

1. Click Measure... in the PressSync curve set editor.
2. Select Automated measurements in the Measure dialog.
3. In the Automated Measurements dialog, verify that the PressSync curves listed in the

Used Curves tab are the ones that were used for printing your test job/chart.

If not, select The sheet is printed with different PressSync Curves and enter the correct
PressSync curve(s) or flexible PressSync curve(s) (including the relevant parameters).

4. Go to the Measurements tab and either:

• measure a control strip, wedge or chart you printed,
• add previously measured data,
• add a profile you measured for your press.

Note:  You can add any number of measurements, measured data sets or profiles to the
list. The resulting compensation curves will be based on all measurements averaged.

5. Each time you perform a new automatic measurement or add measured data or a profile
from a file, it is added to the Measured Data list.

You can Remove some of the measurements if needed, or Show more details about a
measurement.

See Measurement Details on page 56.
6. When you are done, click Go To Results to view the measurement results and the

compensation curves that Curve Pilot calculated.
See Interpreting PressSync Results on page 60.

Measuring a Control Strip, Wedge or Chart
To measure a control strip, wedge or chart you printed:

1. Click Add Automatic Measurement... on the Measurements tab of the Automated
Measurements dialog.

This option is also available from the main menu (Measure > Measure Automatic).
2. In the Automatic Measurement dialog, select the chart type used in your print job from the

Layout selection list.
3. If you want to measure your chart or test job strip patch by patch (instead of line by line),

select Patch Mode.
4. Measure your chart/strip:

a) Reconnect your measuring device (if necessary), and click Start.
b) Follow the instructions in the dialog to complete your measurement; you may have to

click Start several times.

If needed, you can Pause or Stop your measuring device, or click Load Measurement to
use previously measured data.
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You can also measure a test job multiple times if desired.
5. If desired you can view detailed information about the patches you measured.

Select a patch on your layout to view more information about the patch and under which
conditions you measured it. See Measurement Details on page 56.

6. If desired, you can click Save Measurement... (and browse to your desired location) to
export your measurement in the .it8 (CGATS) file format.

7. When you are done, click OK to return to the Measurements tab.

Note:  The data you have measured appears in a temporary system folder using a descriptive
file name containing the AutoMeas_x.it8 suffix, where x is an incremented counter.

Adding Previously Measured Data
To add previously measured data to your curve set:

1. Click Add Measured Data... on the Measurements tab of the Automated Measurements
dialog.

This option is also available from the main menu (Measure > Load Measured Data
(CGATS)).

2. Browse to your measurements file and click Open.

Note:  Your measurements file should be in the .it8 (CGATS) format.

Adding a Measured Profile
If you have measured a profile for your press, you can add it to your curve set, so that Curve
Pilot can use the measured data to calculate compensation curve for your press.

1. Click Add Measured Profile... on the Measurements tab of the Automated
Measurements dialog.

This option is also available from the main menu (Measure > Load Measured Profile).
2. In the Add Measured Profile dialog:

a) Select the Profile Type (Esko Profile or ICC Profile).
You can information about those profile types in the Color Pilot documentation.

b) Select your desired profile from the list.
This lists the profiles saved in your color database (which is on the same server
share as your curves database). If you have measured a profile using Color Pilot, it is
automatically saved in your color database.

c) Click Add Profile.

Measurement Details
When performing an automatic measurement or viewing measurement data, you can see:

• the layout of the control strip, wedge or chart used,
• information about any selected patch on the layout, and details about how it was

measured.
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Patch Details
When selecting a patch, you can see:

• The number of the selected patch (or Sample) on your strip layout (if applicable), and its
composition in your strip layout's ink set.

• The Desired and Measured values for your patch: Lab values, Density and the relevant dot
gain metrics (from the standard or existing curve set you created your curve set from).

• The Desired density values are taken from your desired printing condition (if you want
to change the desired printing condition for your curve set, see Select the Desired Printing
Condition on page 76).

• The Measured density values are taken from your spectral measurements, and indicate
the filter that resulted in the largest density value: (R), (G), (B), or (K).

Note:  It is not always possible to calculate desired density values from a printing condition,
because the printing condition may lack spectral data. In this case the Density and
%DotArea fields will be left blank.

• The Measurement Condition used to measure your strip (this the measurement condition
from your curve set setup, that Curve Pilot set automatically on your measuring device;
to change the measurement condition in your curve set setup, see Select the Desired
Measurement Condition on page 78).

Note:  If your device doesn't support the measurement condition you selected in your
curve set setup, it will use a measurement condition it supports instead. You will see this
indicated.

For information about the different measurement conditions, see Measurement Conditions
on page 106.

• The Metric Preferences used:

• ΔΕ (CMYK) is used to calculate the color difference between process colors.
• ΔΕ (SPOT) is used to calculate the color difference between spot colors.
• Measured densities depend on the filter setting (ANSI A or similar) and may be absolute

or paper relative.

Note:  You can set the metric preferences by going to Edit > Preferences... on the main
Curve Pilot menu. See Application Preferences on page 100 for details.

Measuring the Universal Target Manually
To perform manual measurements on the universal target:

1. Click Measure... in the PressSync curve set editor.
2. Select Universal Target in the Measure dialog.
3. Verify that the PressSync curves listed in the Used Curves tab are the ones that were used

for printing the universal target.

If not, select The Universal Target is printed with different PressSync Curves and
enter the correct PressSync curve(s) or flexible PressSync curve(s) (including the relevant
parameters).

4. Measure the process color vignettes on the Process Colors tab.
5. Measure the paper and gray squares on the Gray Balance tab.
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Process Colors
To measure process color vignettes on the universal target:

1. Make a note of the measured quantity for process colors in your setup. Verify that your
measuring device is set to measure the same quantity. This is commonly %DotArea in
cmyk_ templates and density in 3ck_ templates, but another metric may be used instead.

2. For each process color vignette (Cyan, Magenta, Yellow, and Black if you are working with
a cmyk_ template; CMY (3c gray) and Black if you are working with a 3ck_ template) on the
universal target:

a. Locate the solid patch at position 100 on the vignette and measure it. Enter the
measured value in the Measured Solid <quantity> input field.

b. For each intermediate patch composition (i.e. 25%, 50%, 75%):

• Make a note of the desired value. Desired values are displayed on the vignette:
 

 

• Measure around the intermediate composition until you have found the desired
value.

• Note the position on the vignette where you have located the desired value.
• Enter this position in the corresponding <quantity> of < desired value> found at

input field.

Note:  Press Tab to quickly move from one input field to the next.

Gray Balance
On the Gray Balance tab for the universal target:

1. Measure the Substrate (Paper) and enter the measured Lab values in the L, a, and b input
fields. Press Tab.

2. Note the desired Lab value for the Dark Square. This is shown on the square:
 

 
3. Measure around this area on the Dark Square until you have found the desired Lab value.
4. Enter the coordinates of the Dark Square where you have located the desired Lab value.

 

 
5. Repeat steps (2)-(4) for the Light Square on the universal target.
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Measuring a Control Strip Manually
To perform manual measurements on a control strip:

1. Click Measure... in the PressSync curve set editor.
2. Select A control strip of a production sheet in the Measure dialog.
3. Verify that the PressSync curves listed in the Used Curves tab are the ones that were used

for printing your control strip.

If not, select The production sheet is printed with different PressSync Curves and
enter the correct PressSync curve(s) or flexible PressSync curve(s) (including the relevant
parameters).

4. Measure the process color patches on the Process Colors tab.
5. Measure the gray patches on the Gray Balance tab.
6. If your control strip contains spot colors, measure the spot color patches on the Spot Colors

tab.

Process Colors
To measure process color patches on a production control strip:

1. Make a note of the measured quantity for process colors in your setup. Verify that your
measuring device is set to measure the same quantity. This is commonly %DotArea in
cmyk_ templates and density in 3ck_ templates, but another metric may be used instead.

2. If you are working with a cmyk_ template, measure the 0% patch, the 100% (solid) patch,
and all intermediate patches for Cyan, Magenta, Yellow, and Black.

3. If you are working with a 3ck_ template, measure the 0% patch, the 100% (solid) patch, and
all intermediate patches for CMY (3c gray) and Black.

4. Enter your measurements in the Process Colors tab. Press Tab to quickly move from one
input field to the next.

Gray Balance
To measure gray patches on a production control strip:

1. Measure the 0% patch and enter the measured Lab values in the L, a, and b fields. Press
Tab.

2. Measure the 100% (solid) patch and enter the measured Lab values in the corresponding L,
a, and b fields. Press Tab.

3. Measure each intermediate gray patch and enter the measured Lab values in the
corresponding L, a, and b fields.

Spot Colors
To measure spot color patches on a production control strip:

1. Make a note of the measured quantity for spot colors in your setup.

Verify that your measuring device is set to measure the same quantity. This is commonly
ΔE-P, but %ΔE-P or another metric may be used instead.

2. Enter your measurements in the Spot Colors tab.
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Press Tab to quickly move from one input field to the next.

7.3.3.  Interpreting PressSync Results

To view your PressSync measurements and results, click Go to Results in the Measure dialog.

1. At the top of the dialog, next to Results, you can see the best PressSync curve to use as
compensation curve for each measured ink.
See PressSync Curve Names on page 39 for more information about what the PressSync
curve names refer to.

2. In Select View, choose to view your Measured Curves.

You can also choose Measured and Adjustment Curves if you want to see both side by
side.

a) Check how the measurements of the ink solids compare to the desired values on the
Overview Ink Solids tab.
See Overview Ink Solids on page 61.

Important:  Inspect the Overview Ink Solids results first. Large deviations of the
measured ink solids values from the desired ink solids values imply that the calculated
PressSync dot gain compensation curves should be used with extreme caution.

b) On the Process Colors tab, you can check the measurements for All Inks, each
individual ink, and Gray Balance Measurements.
See Process Colors on page 61.

c) Click the Spot Colors tab and compare your spot color measurements to your desired
values.
See Spot Colors on page 71.

3. In Select View, choose Adjustment Curves.

You can also choose Measured and Adjustment Curves if you want to see both side by
side.

a) If desired, you can set some curve fitting options in the dialog's top right area:

• In PressSync Curve Fit, choose to calculate which PressSync curves to use based on
either a Robust or a Standard fit of your measured points.

See Curve Fitting Options on page 108 for more information.

• Choose to use either a standard or a flexible PressSync curve (select Flexible Curves).

Curve Pilot will recalculate the best PressSync curves to use as compensation curves
based on what you select here.

Note:  This applies to all inks.

b) Below, you can see ink measurements for All Inks and individual process inks.
See Adjustment Curves on page 72.

4. Click Report... to show a combined view of all your measurements results and adjustment
curves.
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You will be able to print this report if desired.

Measured Curves

Overview Ink Solids
The Overview Ink Solids tab details the color difference between measured and desired ink
solids colors, using the ΔE formulas specified in the Curve Pilot Application Preferences.

You can click Preferences... to access the relevant subset of application preferences from
within the Overview Ink Solids tab.

• Measured Lab values plus chroma/saturation (C) and hue (h) for ink solids colors are
extracted from measurements.

Desired Lab values plus chroma/saturation (C) and hue (h) for ink solids colors are extracted
from the desired printing condition for the specific curve set.

• Color differences for process inks are calculated using the ΔE (CMYK) formula, while color
differences for spot inks (non-CMYK inks) are calculated using the ΔE (SPOT) formula.

If a color difference exceeds the tolerance value set in the Preferences (see ΔE (CMYK)
Tolerance and ΔE (SPOT) Tolerance), the color difference value is indicated in red preceded by

.

• Density differences between measured and desired ink solids are displayed in the ΔDensity
column.

Measured density values are extracted from measurements using the density filter and
paper settings set in the Preferences, and the desired density is extracted from the desired
printing condition.

Important:  If the desired printing condition profile does not contain spectral data, the desired
density cannot be extracted. In that case the Desired Density column and the ΔDensity column
will be marked as ‘--'.

Process Colors

Measurements and Curves Details
On the Process Colors tab, you can find additional tabs containing more information about:

1. ink measurements (for All Inks and individual process inks),
2. gray balance measurements.

Curves Selection Parameters
At right you can see and edit some parameters that influence which compensation curves are
selected for your process colors. See Advanced PressSync Settings on page 65.

Note:  The resulting compensation curves are affected by both the advanced settings and your
curve fitting choices.
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Ink Measurements

On the Process Colors tab, you can see ink measurements for All Inks and individual process
inks.

You can see the measured versus desired data displayed in graphs. On each graph, solid lines
indicate desired values; data points indicate measurements.

 

 

For individual inks, you can set some options to control the highlights and shadows
reproduction:

• Under Lightest Printable Dot, indicate the characteristics of your lightest stable highlight
level.

For example, if you noticed that your press only prints in a stable way from 3%, you can set
your minimum dot (the first percentage after 0%) to print at 3%, and gradually increase the
tones from there.

• Enter the input Gray Level that produces your lightest stable highlight level. You can find
it on the curve you used to print that separation.

• Enter the Tone Value that this gray level prints to (this is the minimum tone that you can
print in a stable way, for example 3%).

Tip:  You can enter the Tone Value first and the Gray Level will be calculated
automatically (and vice-versa).

• In Print, enter the value you measured for this Gray Level/Tone Value, in the metric
defined in your template (for example ∆E-P, %DotArea...). You can also find this value by
zooming in on the measurements graph.
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• Under Darkest Printable Dot, you can find the characteristics of your darkest shadow level.
Those are calculated from your measurements by Curve Pilot.

• You can see the input Gray Level that produces your darkest shadow level. If this is not
the solid patch, you will see a warning that your measurements show tone reversal.

• You can also see the Tone Value that this gray level prints to.

• In Print, you can see the value measured for this Gray Level/Tone Value, in the metric
defined in your template.

• In Solid, you can see the value measured for your solid patch, in the metric defined in
your template.

• If your print out shows tone reversal, you can compensate it by screening the solid to the
Gray Level of your darkest shadow.

In this case, enter that gray level in Solid Screen.

Otherwise, keep Solid Screen to 100%.

The resulting curve for that ink will be adjusted to start printing only from your Lightest
Printable Dot, and to print your shadows using your Solid Screen percentage as maximum.

When using flexible PressSync curves:

• the Gray Level you set for your Lightest Printable Dot will be used as Minimum Value,

• the Gray Level of your Darkest Printable Dot will be used as Maximum Value,

• the percentage you use as Solid Screen will determine the Keep 100% parameter (whether
you keep the solid at 100% or screen it to your maximum value).

The highlight and shadow shape of the flexible PressSync curve will also be calculated to
compensate your measurements.

At the bottom of each tab, you can see measured versus desired data in a tabular format (for
all inks or individual inks).

 

 

Solid black lines of text indicate measured results. Gray lines of text indicate desired values.

The numerical values displayed depend on the measurement metric chosen on the Process
Colors setup tab (see Select the Desired Dot Gain Metric on page 76).

• When working with a cmyk template, and the setting for Measure on the Process Colors
setup tab is %DotArea or %ΔE-P, tone value increase (TVI%) graphs are shown by default.

To switch to the usual dot gain graphs, deselect the Show TVI option.

• TVI graphs are not relevant in the case of 3ck_ templates.
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Note:

Curve Pilot calculates tone value increase based on the measurement metric.

• For %DotArea:

     TVI% = %DotArea - %TV 

where %TV is a tone value percentage (patch composition), and %DotArea is the measured
dot area at that tone value.

• For %ΔE-P:

     TVI% = %ΔE-P - %TV 

where %ΔE-P is the measured colorimetric value at %TV.

Gray Balance Measurements

The Gray Balance Measurements tab summarizes measured versus desired values for CMY-
composed gray patches. See Gray Balance Calculations on page 68 for the details.

The top half of the Gray Balance tab displays measured and desired values graphically.

• Measured a* values are shown as data points in red; desired a* values are shown as a
solid / dashed line in red.

• Measured b* values are displayed as data points in blue; desired b* values are shown as a
solid / dashed line in blue.
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• The transition of these target a*, b* lines from solid to dashed indicates the gray balance
feather-off start (a user-defined tone value that marks the start of gradual reduction for
gray balance compensation).

For the details see Gray Balance Feather-Off on page 69.
• The difference between measured and desired L* values is displayed as a weighted delta

Lightness line in black.
• The difference between measured and desired Chroma/hue is displayed as a weighted delta

Chroma/hue line in green.

These can be useful in assessing how far the measured patches are from the perceived
natural color scales specified in the desired printing condition (target). Ideally they should
be straight horizontal lines close to zero.

 

 

The bottom half of the Gray Balance tab displays measured versus desired data in a tabular
format.

Solid black lines of text indicate measured results. Gray lines of text indicate desired values.

The numerical values displayed are colorimetric (Lab values).

Advanced PressSync Settings

At right you can see and edit some parameters that influence which compensation curves are
selected for your process colors.
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Note:  The resulting compensation curves are affected by both these advanced settings and
your curve fitting choices.

Curves Selection
In Select curves based on, you can see what measurements are used to calculate the
compensation curves for process colors:

• Tone Measurements only (the resulting curves only compensate the tone measurements),
• Mainly Gray Balance Measurements (the curves compensate for gray balance),
• Both Tone and Gray Balance Measurements (they compensate for both measurement

data).

Note:  By default, Curve Pilot selects the most appropriate option based on your
measurements. However, if you want to change it, see Gray Balance in CMYK Templates on page
67 for more information.

Gray Balance Control Options

Note:  In most cases, we recommend using the default settings provided by Curve Pilot.
However, if you want to change those settings, use the links below to find more information.

Setting Description

Use gray finder Control how compensation for gray balance is calculated.

See Gray Finder Method on page 69 and Linear Method
on page 68.

Gray Control Feather-Off Start

Gray Control Feather-Off End

Define the range of tonal values where compensation for
gray balance will be gradually reduced (feathered-off).

See Gray Balance Feather-Off on page 69.

Black Aimpoint (a*b*) Determine the method used in feathering-off
compensation for gray balance.

See Black Aimpoint Set to 'G7:0 0' on page 69 and Black
Aimpoint Set to 'Measured' on page 70.

Curves
• You can see the initial curve used for printing (Used Curve) and the resulting compensation

curve (New Curve) for each ink.
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Note:

The resulting compensation curve set will automatically replace the currently used curve set
in Curve Pilot.
 

 

The compensation curves shown under New Curve in the results become the updated
Used Curve set for the next measurement action.

• Click Show Selected Curves to show the information from the Selected Curves tab at right.

• Click Export Curves... to export your resulting PressSync Curve set as a .icpro curve
strategy and .dgc curves. See Exporting PressSync Results on page 73.

Gray Balance in CMYK Templates

CMYK Based Curve Sets and Gray Balance Calculations
The way Curve Pilot calculates compensation points for tone and compensation points for
gray balance is different depending on the curve set template at hand. These differences are
summarized in the following table.

Compensation Type cmyk Template 3ck Template

Tone Compensation is calculated
from desired tone value increase
(TVI) curves specified in an ISO
standard

Compensation is calculated
from density or L target values
extracted from G7 neutral print
density (NPDC) curves

Gray Balance Compensation is calculated from
desired a, b values, and also L
target values extracted from
G7 neutral print density (NPDC)
curves

Compensation is calculated from
desired a, b values only (see Gray
Balance Calculations on page
68)

When creating new curve sets from a CMYK template, Curve Pilot by default calculates
compensation curves for tone only. You can verify this in the Curve Pilot window when viewing
results: the setting for Select curves based on should be Tone Measurements only.

To obtain compensation curves taking into account gray balance, change the default
setting to either Mainly Gray Balance Measurements or Both Tone and Gray Balance
Measurements.

Mainly Gray Balance Compensation in CMYK Curve Sets
With this setting, you can influence compensation towards gray balance in the highlights, and
switch to compensation towards tone in the midtones and/or shadows. The transition point
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will depend on the gray balance feather-off method used. See also Gray Balance Feather-Off on
page 69.

When the black aimpoint is set to G7:0,0 in the Black Aimpoint (a*,b*) selection box (see
Black Aimpoint Set to 'G7:0 0' on page 69), compensation for gray balance starts to fade
out at the Feather-Off Start tone. After that tone, compensation gradually moves towards the
desired TVI curves.

When the black aim-point is set to Measured (see Black Aimpoint Set to 'Measured' on page
70),compensation for gray balance starts to fade out at the Feather-Off End tone. After that
tone, compensation gradually moves towards the desired TVI curves.

When you examine press test runs with compensation curves calculated towards mainly
gray balance targets, you may notice two distinct areas in the Tone Measurements TVI graphs:
a highlights / midtones area where the desired tone values are not met very well, and a
midtones / shadows area where measured dot gain follows the desired TVI curves very well.

Both Tone and Gray Balance Compensation in CMYK Curve Sets
With this setting, compensation towards both tone and gray balance will applied over the
whole tonal range and averaged evenly.

Gray Balance Calculations

The G7 calibration method is based on adjusting curves towards perceived neutral gray scales.
The measured data used by this method is mainly colorimetric.

When the measured color of a neutrally composed gray patch (made of equal percentages of
C, M, Y) deviates from the desired neutral color, you have to correct / shift the individual C, M,
Y components to bring the color back to neutral. This is the principle behind compensation
towards gray balance.

Curve Pilot has two different methods for obtaining curves that compensate towards gray
balance: a linear method and a 'gray finder' method. Both are available on the Gray Balance
Control Options panel when viewing results.

To use the linear method, deselect Use gray finder. The Use gray finder control will be
disabled if your measurements were made on control strip(s) not containing enough neutrally
composed gray patches and/or enough 'gray finder' patches around them; see Gray Finder
Method below.

Linear Method
The linear method assumes a linear relationship between changes in color Lab values and
changes in CMY components. Coefficients for this relationship are derived from the a and b
values measured for the ink solids.

This method takes measurements from neutrally composed gray patches. The measured
Lab values are compared to the desired Lab values that give neutral perceived scales.
Compensation is calculated from the difference, using a linear relationship.

Note:

This method is not suited for printing conditions that use inks with non-linear profiles, i.e. for
inks whose measured a, b values do not scale linearly with tone.

Also, if the measured a, b values are too far away from the desired/aim values, the calculated
curves may not immediately result in neutral scales, and different print iterations may be
required.
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Gray Finder Method
The gray finder method relies on additional 'gray finder' patches around the neutrally
composed ones.

It measures Lab values for the different CMY compositions around each neutral triplet, and
constructs a lookup table of CMY compositions into Lab values. Finding the correct CMY triplet
is then equivalent to looking up the desired a, b values in the table.

The P2P25 calibration target is especially suited for this method: it contains several neutrally
composed gray patches, and 'gray finder' patches around them.

This method can also be used when profiles are used as measurement data. The Lab values of
gray finder patches are then extracted from the profile by interpolation.

Relative Lightness
Curve Pilot uses the latest G7 method for calculating desired/aim a, b values for any neutrally
composed CMY-triplet. In simple terms, this method multiplies the a, b values of the standard
paper by the relative lightness of the CMY-triplet.

The relative lightness (RL) of each triplet is calculated by the following formula:

     RL = (L_ triplet - L_300) / (L_paper - L_300)

where L_triplet is the desired/aim L value of the triplet, L_paper is the L value of the
standard paper, and L_300 is the desired/aim L value of the 100% CMY patch (Cyan=100%,
Magenta=100%, Yellow=100%).

The effect on the Gray Balance Measurements graph is that a, b aim lines in the graph may
not be perfectly straight lines. The a, b aim lines will be more curved (or piecewise straight)
when using paper with more color (higher a or b).

Gray Balance Feather-Off

Why Feather-Off Gray Balance
The G7 method specifies that color of neutral scales should go from paper to perfectly
achromatic; the 100% CMY patch (C=100%, M=100%, Y=100%) should measure a=b=0.

On most real printing conditions, the 100% CMY patch is not perfectly achromatic. To
compensate for that, one or more of the C, M, Y components of the 100% CMY patch would
need to be screened, and this is mostly unwanted (screened solids are generally undesirable).

Because we do not want to screen at 100% CMY, and because we want a smooth transition
towards slightly colored 100% CMY, we have to feather-off (gradually reduce) gray balance
correction in the shadows.

Curve Pilot provides two different methods to this end. The first method gradually reduces the
required CMY shifts / corrections. The second method gradually scales the aim values. Both are
available on the Gray Balance Control Options panel when viewing results.

To use the first method, select G7:0 0 in the Black Aimpoint (a*,b*) list. To use the second
method, select Measured in the Black Aimpoint (a*,b*) list.

Black Aimpoint Set to 'G7:0 0'
This method keeps the a and b aims over the whole tonal range as specified by the G7 method,
but from a certain gray tint onwards (the Gray Control Feather-Off Start) gradually reduces
the required CMY shifts / corrections. The feather-off start is set at 50% by default. There is also
a Feather-Off End tint, which is set at 100% by default.
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On the Gray Balance Measurements chart you will notice that the a, b aim lines change into
dashed lines at the tone value specified in Feather-Off Start.
 

 

The compensation curves obtained with this method fully correct gray balance in the highlights
and mid tones; in the shadows, gray tints gradually follow the natural overprint behavior of the
inks.

You can verify this in the Calculated Curves graphs in Curve Pilot, by selecting the Show tone
and gray compensation points option. Tone compensation points are shown in blue, gray
compensation points are shown in gray. The final adjustment curve fits the gray compensation
points very well up to the feather-off tone; after the feather-off tone, it gradually fits the tone
compensation points (in blue) better.
 

 

Black Aimpoint Set to 'Measured'
This method linearly scales the a, b aim values towards the a, b values measured for the 100%
CMY patch.
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On the Gray Balance Measurements chart you will notice that the a, b aim lines remain solid, but
their slope changes at the tone value specified as feather-off start .
 

 

The curves obtained from this method give rise to neutral color scales in the highlights and mid
tones, and to colors linearly shifting towards the measured 300% CMY patch from the feather-
off tone onwards.

On the adjustment curves calculated from this method, you will notice that the curves now
fit the gray points (the compensation points towards gray balance) over the whole tonal
range. You will also notice that past the feather-off start, these gray points gradually become
linear (X=Y). That is expected; as aim values gradually go towards measured values, required
compensation diminishes.

 

 

Spot Colors
Curve Pilot displays tone measurements for spot colors in the same way as for process colors.
See the section on ink measurements for process colors for details.
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Compensation curves are also calculated and displayed in a similar way, see Selected curves for
details.

Note:  Advanced gray balance options are not applicable to spot colors: compensation curves
are calculated from compensation points for tone only.

Adjustment Curves
The Adjustment Curves tab shows the compensation curves calculated by Curve Pilot for each
process ink present in your setup.

The curves' calculation is affected by your curve fitting choices and by whether they compensate
your tone and/or grey measurements.

The compensation curves are shown for All Inks under the same tab, and for each process ink
on separate tabs.

 

 

Select Show tone and gray compensation points to view tone compensation points (in blue)
and gray compensation points (in gray) on any compensation graph. For the details see Gray
Balance in CMYK Templates on page 67.
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Curves from Tone and/or Grey Measurements
• When using a cmyk_ template, these curves are calculated from compensation points for

tone only by default.

• When using a 3ck_ template, they are calculated from compensation points for gray balance
only by default.

It is possible to change this but we recommend you keep the default. See Curves Selection on
page 66 for more information.

7.3.4.  Saving PressSync Results

To save PressSync results, click Save in the Measure dialog. You will be prompted to Save
curves or Save measurements only.

• Save curves saves the measurements in memory and sets the calculated DGC curves as the
used curves.

• Save measurements only does not update the used curve set.

This action generates an incomplete ( ) record item in the history log. See History of
PressSync Results on page 74 for the details.

7.3.5.  Exporting PressSync Results

Curve Pilot can export calculated dot gain compensation curves for each process and spot
color in your setup in the .dgc file format, and a combined compensation strategy for all colors
in the .icpro file format.

The .prsync curve set and its corresponding .icpro strategy can be used interchangeably
within the Imaging Engine application. However, an .icpro strategy can be expanded by
adding specialized DGC rules for different sets of screening parameters. For the details see
Creating a Strategy on page 34.

To export PressSync results:

1. Click Export Curves... on the Process Colors tab of the Curve Pilot window when viewing
results.

2. In the Export Curves dialog, enter a common Prefix for all .dgc files and for the .icpro
file. You can Overwrite existing files, or enter a unique Prefix. All files will be saved in the
central location of DGC data.

3. Click OK. Curve Pilot will display the list of generated files in the Info Export Curves dialog.
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Note:

Curve Pilot composes file names from the prefix, the name of the .prsync file, the type of
PressSync template (cmyk/tone or 3ck/gray), and the color name:

<prefix>_<prsyncFileName>.icpro
<prefix>_<prsyncFileName>_Comp_<Tone|Gray>_<colorName>.dgc

For the example file myprsync.prsync based on a CMYK template without spot colors, the
following files are generated by default:

tmp_myprsync.icpro
tmp_myprsync_Comp_Tone_Cyan.dgc
tmp_myprsync_Comp_Tone_Magenta.dgc
tmp_myprsync_Comp_Tone_Yellow.dgc
tmp_myprsync_Comp_Tone_Black.dgc

7.3.6.  History of PressSync Results

The History tab displays a list of previously saved setup changes, manual curve changes, and
measurement actions.

For each item on the history list, you can review its 'state' (  column), type of action (Action
column) , resulting compensation curves (Curves column), and timestamp (Date column).
Most recent items are shown first.

The action type can be one of Setup Change, Manual Curve Change, Measured Automatic,
Measured Universal Target, or Measured Control Strip.

A history item can be active ( ), active but incomplete ( ), inactive and incomplete ( ), or
inactive and disabled (grayed-out) because it is superseded by a more recent setup change.

Only items of type Measured Automatic, Measured Universal Target, and Measured

Control Strip can be indicated as active but incomplete ( ) or inactive and incomplete
( ); this means that the measuring action was completed but the resulting (computed)
compensation curves were not set as the ones used for printing subsequent jobs.

You can select an item on the history list and:

• Make it the active item; click Set Active.

Note:

Setting a disabled but completed measurement action (grayed-out) into active ( ) sets
the resulting (computed) compensation curves as the compensation curves to be used for
subsequent measurement actions.

Setting an inactive and incomplete measurement action ( ) into active (in this case )
does not set the resulting (computed) compensation curves as the compensation curves to
be used for subsequent measurement actions.

You can always view the curves used in measurements in the Select Curve Names dialog.

• View information on the item; click Show Info.

74



7Curve Pilot

Note:  For a setup change, a read-only version of the Setup dialog will be displayed. For a
measurement action, the usual window for viewing results will be displayed.

• Delete the item; click Remove.

Note:  You cannot delete the active item ( ) or the last setup change linked to the
active item, or a setup change linked to a measurement action (you have to delete the
measurement action first).

7.4.  Customizing PressSync Templates
Curve Pilot lets you setup your .prsync template in a variety of ways. The following table
summarizes the most common template customizations and a few representative use cases:

Setup Change Use Case

Add or remove spot colors from the
template

Printing to Equinox or another custom system requiring
special inks.

Select the desired dot gain metric for
process or spot colors

Adjusting the measured dot gain metric to in-house
measuring device capabilities and standards; see also
Application Preferences and Dot Gain Metrics in Curve
Pilot.

Select the desired printing condition
for the PressSync template

Using a recently developed profile or a new data
characterization set; generating custom in-house
PressSync templates based on the ones provided with
the application.

Select the desired DGC curves for any
process or spot color in the template

Customizing DGC curves for flexo printing; adjusting
ISO 12647-2/3 curves (offset) to another printing
technology.

Select the desired measurement
condition for your
spectrophotometer

Setting a specific measurement condition automatically
on your spectrophotometer to follow a particular
standard and/or make sure all your measurements are
consistent.

Set the desired values of paper and
solid for any process or spot color in
the template

Using a desired printing condition (profile or data
characterization set) that does not provide spectral
data.

Set custom targets for gray balance Customizing desired colorimetric values employed in
dot gain compensation for gray balance; setting custom
in-house gray balance targets; see also Gray Balance
Calculations in Curve Pilot.
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To start customizing your PressSync template, click Setup... in the PressSync curve set editor.

7.4.1.  Add or Remove Spot Colors

To add or remove a spot color in your PressSync template, go to the Spot Colors tab of the
Setup dialog.

To add a spot color to your curve set, click  and follow the instructions in the Choose Ink...
dialog.

To remove a spot color from your curve set, select it and click .

7.4.2.  Select the Desired Dot Gain Metric

Curve Pilot understands dot gain measurements in a variety of units. You can find the details
under Dot Gain Metrics on page 99.

Setting the Desired Dot Gain Metric for Process Colors
1. Go to the Process Colors tab of the Setup dialog.
2. Select the desired metric in the Measure list. The default metric depends on the type of

template you chose.

Template Default metric

Templates based on ISO 12647 %DotArea

Templates based on G7 density

Linear dot gain templates %DotArea for cmyk_LinearDensity.prsync

∆E-P for cmyk_LinearColor.prsync

Setting the Desired Dot Gain Metric for Spot Colors
1. Go to the Spot Colors tab of the Setup dialog.
2. Select a spot color in the Spot Colors pane.
3. Select the desired metric in the Measure list. The default value is SCTV (for all template

types).

You can set different dot gain metrics for different spot colors.

7.4.3.  Select the Desired Printing Condition

A desired printing condition is a characterization of your press should ideally print. You can
change the desired printing condition of your PressSync template to:

• generate a PressSync template for a printing specification / standard not implemented in
Curve Pilot,
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• combine printing targets from more than one printing specifications / standards (e.g.
GRACoL and ISO 12647-2 Type 1, SWOP and ISO 12647-2 Type 3).

1. Go to the General tab of the Setup dialog.
2. Click Change... next to the Desired Printing Condition field.
3. Select the Profile Type for the new Desired Printing Condition. This can be an ICC Profile,

an Esko Profile, or a Fogra Characterization Data set.

Note:  Profiles are stored in the central location of CMS data, i.e. \\server
\bg_data_cms_v010\.

4. Click  to review a summary of the profile.
5. Enter a short description for your new curve set in the Curve Set Description area.

A useful curve set description includes information about your printing standard, desired
dot gain values, paper type, screen/ruling parameters, and/or any other specific operating
conditions.

7.4.4.  Select the Desired Dot Gain Curves

By default, Curve Pilot extracts desired dot gain curves from the printing standard associated
with your curve set template.

If you are working with a cmyk_ template, you can set desired (target) dot gain curves for each
process color (C,M,Y,K) separately.

If you are working with a 3ck_ template, you can only set desired dot gain curves for CMY-
composed gray (3c) and black (k).

If you select Extract curves from desired printing condition, desired curves will be extracted
automatically from the profile (or data characterization set) specified as the Desired Printing
Condition under the General tab.

The resulting dot gain curves will be very close to the ones extracted directly from the
template's standard, but not identical.

Note:  You may want to select Extract curves from desired printing condition if your desired
printing condition is a profile containing spectral data. This way, reliable density values will be
calculated from the spectral data.

Changing the Desired Dot Gain Curve for a Process Color
1. Go to the Process Colors tab of the Setup dialog.
2. If the Desired Curves panel is collapsed, click on  to expand it.
3. If you are working with a cmyk_ template, select the desired (reference) dot gain curve from

the list for Cyan, Magenta, Yellow, or Black.

If you are working with a 3ck_ template, select the desired (reference) dot gain curve from
the list for CMY (3c gray) or Black.

In both cases, you can select a custom desired dot gain curve specified in a .dgc file, a
Linear dot gain curve, or a User Defined dot gain curve.
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Note:

Generating a User Defined dot gain curve for a process color requires entering target dot
gain values manually. For details, see User Defined Dot Gain Curves for Process Colors  on page
114.

This process is deprecated and no longer recommended. You can always import custom
reference dot gain curves specified in .dgc files instead.

4. Click  to preview the curve.

Changing the Desired Dot Gain Curve for a Spot Color
1. Go to the Spot Colors tab of the Setup dialog.
2. Select a spot color from the Spot Colors list.
3. Select the desired (reference) dot gain curve for the selected spot color from the Desired

Curve list.

You can choose between a Linear curve, a User Defined curve, or the curve that Curve Pilot
will Calculate from ink profile automatically.

Note:  Generating a User Defined dot gain curve for a spot color requires entering target
dot gain values manually. For details, see User Defined Dot Gain Curves for Spot Colors  on
page 115.

4. Click  to preview the curve.

7.4.5.  Select the Desired Measurement Condition

You can set the measurement condition to use when measuring test jobs/charts for your curve
set, so that all your measurements are consistent.

Note:

If you have created your curve set from a template that specifies a measurement condition (for
example cmyk_FOGRA51 specifies M1), the template's measurement condition is set here in
your curve set setup automatically.

In this case, we recommend you don't change it (to keep adhering to the standard in the
template).

The measurement condition you select here will be set automatically on your measuring
device.

Note:  Make sure you select a measurement condition supported by your measuring device,
otherwise it will use a measurement condition it does supports instead. If this happens, you
will see it indicated when performing measurements.

To set a measurement condition:

1. Go to the General tab of the Setup dialog.
2. In Measurement Mode, select the measurement condition to use.
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See Measurement Conditions on page 106 for information about the different
measurement conditions.

7.4.6.  Set the Desired Values of Paper and Solid

You can change the target values for the paper and solid in your chosen dot gain metric.

Note:  These values do not affect the final dot gain compensation curves calculated by Curve
Pilot.

You may want to do this if your desired printing condition is:

• an ICC profile,

a characterization data set without spectral data.

Note:

You do not need to enter desired density values for paper or solid if your desired printing
condition is a profile containing spectral data. Curve Pilot will calculate reliable density data
from the spectral data automatically.

To quickly check if your profile contains spectral data, click  next to the Desired Printing
Condition field on the General tab of the Setup dialog.

To Change the Desired Values of Paper and Solid for Process Colors
1. Go to the Process Colors tab of the Setup dialog.
2. If the Desired [value] of Paper and Solid panel is collapsed (where [value] is your dot gain

metric), click on  to expand it.
3. If you are working with a cmyk_ template, enter the desired densities for Cyan, Magenta,

Yellow, or Black under Paper and Solid.

If you are working with a 3ck_ template, enter the desired densities for CMY (3c gray) or
Black under Paper and Solid.

To Change the Desired Values of Paper and Solid for Spot Colors
1. Go to the Spot Colors tab of the Setup dialog.
2. Select a spot color from the Spot Colors list.
3. Under Desired [value] for Paper and Solid (where [value] is your dot gain metric), enter

the desired Paper and Solid values for the selected spot color.

Note:

For both process and spot colors, make sure to enter values corresponding to your chosen dot
gain metric:

• if you are working with the density or %DotArea metric, enter density values for process
colors paper and solid,

• if you are working with the ΔE-P or %ΔE-P metric, enter ΔE-P values,

• if you are working with the SCTV metric, enter SCTV (Absolute) values (paper and solid
SCTV values relative to the absolute white point).
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7.4.7.  Set Custom Targets for Gray Balance

To modify the desired Lab values (colorimetric targets) of CMY-composed gray patches, go to
the Gray Balance tab of the Setup dialog.

If you are working with a cmyk_ template and you will be compensating for tone only, you do
not need to worry about these settings. For the details, see Advanced PressSync Settings on page
65 and Gray Balance in CMYK Templates on page 67.

If you are working with a 3ck_ template (or if you are working with a cmyk_ template and want
to compensate for gray balance in addition to tone):

1. If you set your gray balance Aim to the profile serving as the Desired Printing Condition
under the General setup tab, desired values are extracted from the profile by default.

In this case you can only modify the number of intermediate Patches (excluding paper and
solid) on the control strip, and the compositions of these intermediate patches.

2. If you set your gray balance Aim to Paper Relative or User Defined, you can also:

a. Modify the Lab values for paper and solid under the Desired Values on the Universal
Target and Desired Values on a Control Strip panels.

b. Modify the desired Lab values for Cyan, Magenta, and Yellow solids under the Desired
Values of the Solid Process Colors panel.

3. If you set your gray balance Aim to User Defined, you can additionally modify the desired
Lab values of all gray patches under the Desired Values on the Universal Target and
Desired Values on a Control Strip panels.

Note:  Setting your gray balance Aim to User Defined allows you to enter CMY triplets for
gray patches that do not conform to the Neutral Gray CMY Triplet Table on page 116.
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8.  Working with Curves from the Print
Control Wizard

What is the Print Control Wizard?
The Print Control Wizard is an application designed to help you optimize your print quality.

Based on your exact production workflow, your current print quality and the standard you
want to print towards, the Print Control Wizard calculates the best possible screens and curves
that you can use to achieve great results on press.

This helps you avoid common problems, for example a lack of smoothness in the transition
from highlights to paper, or from shadows to solids, and makes getting good printing quality
time after time easier.

See Print Control Wizard for more information.

Printing Condition and Curves
The Print Control Wizard generates a printing condition based on your production workflow
settings and the measurement results of a print sample made with those settings.

This printing condition:

• describes your exact production workflow (plate-making workflow and printing setup) and
the way it prints,

• includes the standard you want to print towards (an ISO standard, linear printing...),
• results in the best possible curve(s) and screen(s) to achieve the quality of that standard

with your production workflow.

The Print Control Wizard generates flexible PressSync curves, collected in a PressSync curve set.

PressSync curve sets created by the Print Control Wizard are automatically saved to your
curves database, as any other PressSync curve set.

8.1.  Advanced Workflow
The Print Control Wizard is intended to be easily usable, and to give you great results whether
you are a novice or an expert user.

You can find a detailed explanation of the basic Print Control Wizard workflow in the Print
Control Wizard documentation.

However, if you are an expert user, we understand that you may want to inspect and in certain
cases further fine-tune the results from the Print Control Wizard.

In this advanced workflow, you will need to use the Print Control Wizard, Imaging Engine and
Curve Pilot.

1. Linearize your separations in the Print Control Wizard.

We recommend that you create, print and measure a sample for first Magenta and then
Black. This is because:
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• Magenta ink is typically more pigmented than Cyan or Yellow ink, so Magenta highlights
are more sensitive to small variations of the minimum dot.

• Black ink typically behaves differently from Cyan, Magenta or Yellow ink.

Copy the curve the Print Control has found for Magenta to your Cyan and Yellow
separations.

See the Print Control Wizard documentation for details.
2. Use the printing condition generated by the Print Control Wizard to RIP a 4 color job in

Imaging Engine.

We recommend you use a P2P25 chart as your test job, as it contains a 4 color tone scale.

See the Imaging Engine documentation for details.
3. Print your test job using the exact plate-making workflow and printing setup you used to

make your printing condition.
4. Measure your test job and add the measurements to your printing condition's curve set in

Curve Pilot.
See Adding Measurements to a Printing Condition's Curve Set on page 82.

5. Inspect your new curves (created from the Print Control Wizard curves and your new
measurements) for each separation.

See Inspecting your Curves on page 83.
6. If necessary, you can fine-tune your measurements and your adjustment curves to:

• adjust the minimum printable dot and the tone it produces on print,
• adjust the level of FM in your highlights,
• adjust the shadows (if you are still experiencing tone reversal).

See Fine-tuning Your Measurements on page 88 and Fine-tuning Your Adjustment Curves on
page 90.

7. Use your fine-tuned curve set in production.

8.1.1.  Adding Measurements to a Printing Condition's Curve Set

After printing a test job with your printing condition, you can measure it and add the
measurements information to your printing condition's curve set.

Tip:

You can either:

• measure the job then open the curve set in Curve Pilot and add the measurements,
• open the curve set in Curve Pilot and measure the job from there.

1. As the Print Control Wizard generates flexible PressSync curves, you need to first enable
flexible PressSync curves in the Curve Pilot Preferences.
See Flexible PressSync on page 100.

2. Open the PressSync curve set that the Print Control Wizard created as part of your printing
condition:
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a) Open your curves database folder (the right location is opened automatically when you
go to File > Open).

b) In the Files of type filter, select PressSync Curve Sets (*.prsync).
c) Select the curve set created by the Print Control Wizard (it will be called

PCW_[your_printing_condition_name].prsync), and click Open.

Tip:  You can see the name of the curve set on the printing condition's Report page in
the Print Control Wizard.

3. In the PressSync curve set editor window, click the Measure... button, then select
Automated measurements.

4. In the Automated Measurements dialog, either:

• Click Add Automatic Measurement... to measure your 4 color test job.
• Click Add Measured Data... to add a measurements file if you have already measured

your job elsewhere.

See Automated Measurements on page 55 for more details.
5. Click Go To Results to see your new curves (created from the Print Control Wizard curves

and your new measurements).

See Inspecting your Curves on page 83.

8.1.2.  Inspecting your Curves

After adding 4 color measurements to your Print Control Wizard curve set, you can inspect your
measurement data in the Automated Measurements dialog.

1. At the top of the dialog, you can see the names of your new adjustment curves next to
Results.

Those curves are based on:

• the initial adjustment curves generated by the Print Control Wizard, that you used to print
your P2P25 chart,

• your P2P25 chart measurements.

Your new curves may be identical to or different from your initial curves (they may be a little
different because of the interaction between different inks in the P2P25 chart's overprints,
which mimics the complexity of a real life print job more closely than the Print Control
Wizard's single separation chart).

2. On the Overview Ink Solids tab, check the color values of the solid patches you measured,
and how close they are to the desired values for your separation's solids.

See Overview Ink Solids on page 61.

Attention:  If the measured values are significantly different from the desired

values, you will see a warning sign . In this case, you should stop and troubleshoot
your printing process.

3. Check the transition point for all your separations.
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The transition point is the point at which your screen transitions from AM (conventional
screening) to FM (stochastic screening) when going into the finer highlights.

You can see this indicated in red below.

 

 

To check the transition point, do the following:

a) Make sure that the Select View option (above the tabs) is set to Adjustment Curves.
b) Click the Process Colors tab, then the All Inks sub-tab.
c) You can see the new adjustment curves for CMYK, with the Bump and transition point

(TP) used for each curve mentioned next to the separation name.
4. Inspect each transition point's grey level on your Print Control Wizard's test charts.

You need to:
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• Check the transition point's grey level of the Magenta, Cyan and Yellow adjustment
curves on the Magenta test chart.

• Check the transition point's grey level of the Black adjustment curve on the Black test
chart.

See Inspecting the Test Chart's Transition Point on page 85.
5. If:

• you are satisfied with the recommended levels of FM for all separations, you can just
save your curve set and use it in production,

• you want to use a different level of FM, enter the gray level of your desired transition
point as Desired Transition Point. See Transition Point adjustment.

Note:  Use your desired transition point grey level from the Magenta test chart for the
Magenta, Cyan and Yellow adjustment curves, and the one from the Black test chart for
the Black adjustment curve.

You can also view more details or fine-tune your (measurement or adjustment) curves further.
See:

• Fine-tuning Your Measurements on page 88,

• Fine-tuning Your Adjustment Curves on page 90.

Inspecting the Test Chart's Transition Point
On your Print Control Wizard's test chart, the HIGHLIGHT CHECK A area contains several
highlight gradients (from 0 to 30%) for your screen technology:

• the Crystal and Crystal C screens if you made a printing condition for printing on flexible
materials,

• the Crystal screen if you made a printing condition for printing on labels.
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Each gradient uses a different minimum dot (the number of pixels composing the minimum
dot is indicated at the bottom of the gradient).

For each gradient, you can see the FM Dot Populations available in the Print Control Wizard
(1/1,1/2 and 1/4) indicated by gray dashes.

The FM dot population indicates the amount of dots used to print the lightest highlights.

1/1 means that all the dots are kept (the screen doesn't use
FM screening)
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1/2 means that half of the dots are kept (resulting in FM
screening)

1/4 means that a quarter of the dots are kept (resulting in FM
screening)

A lower FM dot population gives lighter highlights, but may
increase graininess.

Find the minimum dot and FM dot population chosen by the Print Control Wizard for that
separation, and check whether you are satisfied with the lightness and graininess of that area.
We recommend you use a magnifier (of 12x magnification factor or more) and a light booth.

 

87



8 Curve Pilot

 

If you are not satisfied with it, check the different gradients to examine the lightness and
graininess for different minimum dots and levels of FM, and find a better transition point.

In the Print Control Wizard you could choose to use either a 1/1, 1/2 or 1/4 FM dot population
for the lightest highlights, but with Curve Pilot you can choose any level of FM that looks good
to you.

 

 

If you want to use a different level of FM for your lightest highlights, note the gray level that it
corresponds to. You can change it in Curve Pilot (see Transition Point adjustment).

8.1.3.  Fine-tuning Your Measurements

After adding 4 color measurements to your Print Control Wizard curve set, you can inspect your
measurement data and fine-tune it if necessary (for example if you think that some of the
measurements are not representative of how your press prints).

1. To check your measurements in detail:
a) Make sure that the Select View option (above the tabs) is set to Measured Curves (or

Measured and Adjustment Curves if you want to see both curves side by side).
b) Click the Process Colors tab, then the sub-tab of the separation you want to inspect.
c) On the graph, you can see your measured points, and the desired curve taken from the

standard you have chosen to use in the Print Control Wizard.
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d) You can zoom in  on the graph to inspect:

• the highlights,
• the shadows,
• the transition point.

e) Under the graph, you can see the desired and measured values for each point in a table.
2. Next to the graph, you can see the characteristics of the screen generated by the Print

Control Wizard for that separation in the Screen Info area.

You can see the screen's Name, Ruling, Highlight Dot (the minimum dot it uses in the
highlights, in number of pixels and corresponding screen percentage), and whether or not is
uses Surface Screening on the solids.

3. If desired, you can fine-tune your minimum tone using the Lightest Printable Tone
options.

The application zooms in on the highlights automatically when using this set of options so
you can examine this area better.

You can:

• change the minimum printable dot/input percentage (in the Found At field),

• change the tone it produces on print (in the Measured Tone Value field).

You can see your changes reflected immediately on the graph.
4. The Darkest Printable Tone area shows you:

• whether there is tone reversal in the shadows (you will see a warning sign ),

• the maximum input percentage (in Found At),

• the tone it produces on print, measured in the metric defined in your chosen standard
(for example Darkest ∆E-P if your standard uses ∆E-P),
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• the value produced on print by the solid tones, measured in the metric defined in your
chosen standard (for example ∆E-P at 100%).

You cannot fine-tune the shadows' measurements. However, if you experience tone
reversal, you can fine-tune the adjustment curve's shadows. See Maximum.

Note:

Fine-tuning the shadows is not recommend when working with Crystal screens based on
the Pixel+ technology, as those screens contain surface screening in the 100% tones to
prevent tone reversal.

The Print Control Wizard generates such Crystal screens for printing on flexible materials,
but it is also possible to generate them for printing on labels.

See the Print Control Wizard documentation for more information.

5. Under Transition Point, you can fine-tune the level of FM in your highlights.

The application zooms in on the highlights automatically when using this set of options so
you can examine this area better.

On the graph, you can see the transition point indicated in dark blue, and the part of the
highlights reproduced with FM screening indicated by a pink area.

 

 

The Measured Tone Value is the tone at which the AM to FM transition happens.

To fine-tune the transition point:

1. Select Adjust FM Range.
2. Under Desired Transition Point, you can either:

• keep Default (Optimal highlights) selected to keep the transition point calculated as
optimal by the Print Control Wizard,

• select User Defined if you want to change it (enter the tone value at which you want
the transition from AM to FM to happen).

8.1.4.  Fine-tuning Your Adjustment Curves

You can also inspect and if necessary fine-tune your adjustment curves' highlights, shadows
and transition point.

1. To inspect your adjustment curves:
a) Make sure that the Select View option is set to Adjustment Curves (or Measured and

Adjustment Curves if you want to see them side by side).
b) Click the Process Colors tab, then the sub-tab of the separation you want to inspect.
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c) On the graph, you can see the adjustment points (adjusting your measured points to have
them print like your chosen standard), and the adjustment curve made by these points.
 

 

The new adjustment curve (and adjustment points) are in blue, while the previous
adjustment curve (generated by the Print Control Wizard) is shown in grey.

d) As with the measurements graph, you can see the characteristics of the screen generated
by the Print Control Wizard.

2. If desired, you can change some general curve fitting options:
a) At the top right of the dialog, choose whether you want a Standard or Robust

PressSync Curve Fit.
See Curve Fitting Options on page 108 for more information.

b) Choose whether to use Flexible Curves or regular PressSync curves.
Flexible PressSync curves contain additional options to address specific flexo printing
challenges.

3. If you want to fine-tune the highlights or shadows of the adjustment curve, use the
Adjustment Options next to the Adjustment Curve graph.

The application zooms in on the highlights automatically when using this set of options so
you can examine this area better.

•
The Minimum  value is the adjustment applied to the minimum printable tone (the
first tone after 0%, as the 0% tone always remains at 0%).

For example, you can decrease the minimum value from 1% to 0.5% if you want finer
highlights.

•
You can use the Keep 0% until option to eliminate the highlights level you don't want
to print.

For example, if the tones up to 0.8% print in a very unstable way, you can choose to turn
those into 0% so they won't be printed.
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•
The Maximum  value is the adjustment applied to the maximum printable tone (the
tone just below 100%).

If you experience tone reversal (you will see a warning sign ), you can decrease this
value.

Note:

Fine-tuning the shadows is not recommend when working with Crystal screens based on
the Pixel+ technology, as those screens contain surface screening in the 100% tones to
prevent tone reversal.

The Print Control Wizard generates such Crystal screens for printing on flexible
materials, but it is also possible to generate them for printing on labels.

See the Print Control Wizard documentation for more information.

4. Under Transition Point, you can fine-tune your transition point, and change how your
adjustment curve fits your transition point.
a) Enter your Desired transition point (at which percentage you want the transition

between AM and FM to happen in your output).

By default, this shows the transition point that the Print Control Wizard calculated as
optimal, but you can for example lower it if you prefer having less FM in the highlights.

Tip:  Enter the gray level you have chosen on your test chart here.

b) Choose what you want to Prioritize when fitting the adjustment curve:

• the Transition Point (if you want the curve to go very closely through the transition
point you defined, at the expense of the individual adjustment points),
 

 

• the Adjustment Points (if you want the curve to go very closely through the
individual adjustment points, at the expense of the transition point you defined).
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c) The Actual transition point is calculated based on what you prioritized.
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9.  The Preview Combined Curves Tool
The Preview Combined Curves tool lets you preview the combined compensation result of
multiple curves on a print job. The tool lets you select one compensation strategy (.icpro) or
PressSync curve set (.prsync) for the press, an additional dot gain compensation curve (.dgc)
for the press, as well as a separate compensation strategy (.icpro) or curve set (.prsync) for
the plate.

You can use Preview Combined Curves to preview a combination of curves and to simulate
a print job compensated by multiple curves, in a fashion similar to performing a simple (one
curve) Print simulation in the Curve Pilot editor.

Additionally, you can use Preview Combined Curves to look into complex strategies (.icpro)
and determine which compensation curve is used based on context (job parameters such as
images / linework, separation, dot shape, ruling, and screening angle).

Finally, you can use Preview Combined Curves to preview the stochastic range of SambaFlex
screens and the shifting of their transition points from stochastic to conventional grids. For
more information about SambaFlex screens, please refer to the Esko screening manual(s).

9.1.  Previewing a Combination of Curves
Add the desired curves, strategies, and/or PressSync curve sets under Rip Dot Gain
Compensation:

1. Add an .icpro ink-based strategy or .prsync curve set for the press in the Automatic
Press list.

2. Add a single .dgc press compensation curve in the Single Curve Press list.
3. Add an .icpro ink-based strategy or .prsync curve set for the plate in the Automatic

Plate Making list.
4. Leave all settings under Context to default.

You can preview the resulting combined compensation curve in the Combined Curves area.
Compensation data points are shown in the Compensation Values Table.

The order of evaluating compensation curves is shown in the Compensation Values Table and
also in the Curves area:

1. The main press curve (Automatic Press) is applied first.
2. The extra press curve ( Single Curve Press) is applied second.
3. The plate compensation curve (Automatic Plate Making) is applied last.

Note:  You cannot change this evaluation order in Curve Pilot. If you are using Imaging Engine,
you can change the order of applying the extra press curve; for the details, see your Imaging
Engine manual.
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Print Simulation
Add measured dot data saved in a .dgc file in the Plate Processing Simulation list. Select
the compensation curves to use under Curves. Make sure that step (4)->(5) under Curves is
selected.
 

 

The Combined Curves graph now displays two curves: a combined compensation curve
in blue, and a simulated dot gain curve in red. The simulated dot gain curve in red is the
result of applying the combined compensation curve (blue) on the measured (normally
uncompensated) data.
 

 

These measured data will normally form a dot gain curve that characterizes the plate
processing phase of your workflow, but they can also appear in the form of a dot loss curve in
the case of flexo printing, specifying how the plate wash-out process behaves.

Note:  This preview is purely informative and final RIP results may not coincide with preview
data.
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9.2.  Previewing the Results of a Strategy
An .icpro strategy can be complex and the compensation curve selected for a specific context
(set op operating parameters) may not be immediately obvious by examining the strategy (see
How the RIP Retrieves the Right DGC Curve on page 37).

The Preview Combined Curves tool lets you determine which compensation curve is used
based on job parameters such as images / linework, separation, dot shape, ruling, and screen
angle.

To use this feature:

1. Add the .icpro ink-based strategy for the press in the Automatic Press list.
2. Under Context, enter the job parameters for which you want to discover the compensation

curve that will be used by the RIP application:

a. Select between Images (CT) or Linework (LW).
b. Select the Ink Name from an Ink Book.
c. Select the Dot Shape.
d. Enter the desired Ruling and Angle.

Example
A sample .icpro strategy contains special compensation curves for linework (all process inks)
at 100 lpi and 120 lpi. You want to discover the compensation curve used for linework at 110
lpi.
 

 

Select the strategy name in Automatic Press, then under Context select Linework (LW) and
enter 110 for Ruling. The right compensation curve is displayed in Curves.
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Note:  Curve Pilot selects the compensation curve with the smallest lpi.

9.3.  Previewing the Stochastic Range of SambaFlex
Screens

In the Compensation Values Table of the Preview Combined Curves dialog, you can preview
the stochastic range of SambaFlex screens in the highlights and (possibly) in the shadows; both
ranges will be highlighted in blue.
 

 

This feature is only available when you select a Dot Shape under Context from the HDFlexo
family of screens (HD01...), or the SambaFlex family of screens (SC01...), or any other hybrid
screen generated by the Screen Manager application (SCR01...). Make sure that Show
stochastic range under SambaFlex Details is selected as well.

Under SambaFlex Details, you can preview key parameters of the selected screen: Resolution
in ppi, Dot Shape (same as the dotshape selected above), Actual Ruling in lpi, and Minimum
Dot Size in pixels.

You can edit the values of Resolution and Minimum Dot Size to get an idea of the shifting
of transition points. You may observe a trend: lower resolution to minimum dot size ratios
give rise to broader stochastic ranges both in the highlights and in the shadows. This is to be
expected; with a coarser setup (a lower resolution and/or a higher minimum dot size), the
stochastic ranges have to move more into the midtones for the desired dot gain compensation
effects to materialize.
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10.  Archiving DGC Data
You can pack any number of .dgc, .icpro, .scrdgc, and .prsync files into a single .icpack
archive.

To create the archive, select File > Pack... from the top Curve Pilot menu, and follow the
instructions in the Pack dialog. You can add any number of files to the archive and save it
under the desired name and folder. You do not need to specify a file extension for the archive;
the .icpack file extension will be appended automatically.

To unpack the archive, select File > Unpack... from the top Curve Pilot menu and follow the
instructions in the Unpack dialog. The archived files will be extracted to the central location
of DGC data. If you do not wish to overwrite files in that location, make sure that Overwrite
existing files in the Unpack dialog is disabled (unchecked).
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11.  Appendices

11.1.  Location of Data Files
The following table summarizes the location of most common data files used by Curve Pilot. All
paths are absolute. \\root denotes the root installation folder of Curve Pilot, and \\server
denotes the central location of automation data. \\root and \\server may be identical.

The central location of DGC data is \\server\bg_data_dgc_v010\.

File Type Extension Location

Characterization data set .txt \\root\bg_data_intellicurve_v160\

Control strip layout description .it8 \\root\bg_data_intellicurve_v160\

Control strip file .pdf \\root\bg_prog_intellicurve_v160\dat
\doc

Dot gain compensation file .dgc \\server\bg_data_dgc_v010\

Dot gain compensation
strategy file

.icpro \\server\bg_data_dgc_v010\

Dot gain compensation target
(reference) file

.dgc \\server\bg_data_dgc_v010\refdgc

Press sync curve set .prsync \\server\bg_data_dgc_v010\

Screen dot gain compensation
strategy

.scrdgc \\server\bg_data_dgc_v010\

11.2.  Dot Gain Metrics
Curve Pilot can work with different types of dot gain measurements. You can find some
information about these in the table below.

Metric Description Usage Values

Density The optical density of reflected
light

Use a densitometer set to the
desired density filter for your
region / specifications (see Curve
Pilot Preferences)

From
0 (no
maximum)

%DotArea The amount of reflected light from
a screened area, compared to
paper and solid

Use a densitometer that can
calculate %DotArea using the
Murray-Davies equation

0% to
100%

SCTV
(Spot
Color

The tone of a color tint calculated
from Lab values (based on

Use a spectrophotometer with
ΔE calculations set to CIE-1976 or

0% to
100%
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Metric Description Usage Values
Tone
Value)

measured spectral data) instead of
density values

more recent standard (see Curve
Pilot Preferences)

ΔE-P A colorimetric measurement
indicating the color difference
between a color patch and the
paper

Use a spectrophotometer with
ΔE calculations set to CIE-1976 or
more recent standard (see Curve
Pilot Preferences)

From
0 (no
maximum)

%ΔE-P A colorimetric measurement
indicating the color difference
between a color patch and
the paper, relative to the color
difference between solid and
paper

Use a spectrophotometer with
ΔE calculations set to CIE-1976 or
more recent standard (see Curve
Pilot Preferences)

0% to
100%

11.3.  Application Preferences

Densitometer measures:
Choose between Percentages and Densities. This setting must be consistent with the setting
used in your measuring device, so that Curve Pilot can calculate dot gain compensation curves
correctly.

Number of Compensation Values:
Set the number of calculated compensation points when generating dot gain compensation
curves.

Flexible PressSync
Select Enabled if you want to work with flexible PressSync curves. You can then:

• use flexible PressSync curves parameters when making a curve set,

• use the flexible PressSync curves shapes to fit other curves,

• open curve sets containing flexible PressSync curves (for example curve sets created by the
Print Control Wizard).

ΔE (CMYK) Formula:
This is the color difference formula to use when comparing process colors (C,M,Y,K). Colors are
compared in the Overview Ink Solids tab, in the Automatic Measurement dialog, and in reports.

The following color difference formulas are supported: CIELAB Delta E (Classic), Delta E 94,
Delta E 2000, CMC (1:1), CMC(2:1).

Selection of the right formula depends on the printing process control standard used in your
environment. Most ISO printing standards specify color difference tolerances based on the
Classic ΔE formula for process colors, and on the Delta E 2000 formula for spot colors.

ΔE (CMYK) Tolerance:
This is the maximum color difference allowed between measured and desired process colors.
This value is used in the Overview Ink Solids tab and in reports. When the color difference
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between the measured ink solid and the desired ink solid exceeds the ΔE (CMYK) tolerance
value, the values in these panels are marked in red.

ΔE (SPOT) Formula:
This is the color difference formula to use when comparing spot colors, i.e. any non-CMYK
colors. The same formulas as ΔE (CMYK) are supported.

ΔE (SPOT) Tolerance:
This is the maximum color difference allowed between measured and desired spot colors. It
works similarly to the ΔE (CMYK) Tolerance.

Density Filter:
This is the density filter or ‘response’ used by densitometers, determining the reflected light
captured over a specific range of wavelengths. It is important to select the density filter that is
used by your measurement device. The following table provides a quick reference.

Filter Application Notes ISO Equivalent

ANSI A Wide-band color reflection and transmission
response; used mainly in the photographic
industry for measuring prints and slides

ISO STATUS A

ANSI T Wide-band color reflection response; used
mainly in the US

ISO STATUS T

DIN Wide-band color reflection response; used
mainly in Europe; produces higher values for
yellow than ANSI T / ISO STATUS T

ISO STATUS E

DIN NB Narrow-band densitometer response; rarely
used

ISO STATUS I

ISO STATUS A ISO version of ANSI A

ISO STATUS M Wide-band color transmission response;
used mainly in the photographic industry for
measuring negatives

ISO STATUS T ISO version of ANSI T

ISO STATUS E ISO version of DIN

ISO STATUS I Narrow-band densitometer response; rarely
used

Density Paper:
Choose if the density values displayed in the Overview Ink Solids tab, in the Automatic
Measurement dialog, and in reports should be relative to the paper or not.

Decimal Separator:
Select the desired decimal separator (point/dot or comma) when importing/exporting
numerical values in plain text files.
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11.4.  Print Chart Layouts
Predefined chart layouts are provided with Curve Pilot to support automated measuring of
prints. When measuring a control strip, wedge or chart, these can be selected from the Layout
list.

Chart layouts are text files with the .it8 extension. The actual charts are .pdf files; some are
provided with your Curve Pilot installation. See Location of Data Files on page 99 in Curve
Pilot.

The following table summarizes the chart layouts (.it8) currently supported by Curve Pilot in
automated measurements mode. When .pdf files are available, this is clearly indicated in the
table. A separate section discusses Control Strips for Equinox on page 103.

Chart Layout PDF Available Notes

ECI_GrayConL_v2.it8 No www.eci.org

ECI_GrayConM_v2.it8 No

ECI_MediaWedge_v30.it8 No www.fogra.org

ECI_MediaWedge_v30a.it8 No

ECI_MediaWedge_v30b.it8 No

IDEAlliance ISO 12647-7_Control
Strip 2009.it8

Yes www.idealliance.org

IDEAlliance ISO 12647-7_Control
Wedge 2013.it8

Yes

IT874_cmyk_Visual.it8 No

IT874_cmyk_Random.it8 No

MASA_7c_Control_Strip_1x35.it8 No

P2P25.it8 Yes

From Layout No

The selection entry From Layout generates a chart layout from the settings used in the curve
set's Setup dialog.

This layout takes into account:

• the number of patches for process colors set in the Process Colors tab,

• the number of patches for CMY-composed gray set in the Gray Balance tab,

• the number of patches for spot colors set in the Spot Colors tab.

11.4.1.  The Universal Target

The Universal Target is available as .pdf file. You can use it to manually measure process
colors (C,M,Y,K) and CMY-composed gray.

102



11Curve Pilot

Universal Target Location

Universal4cTarget.v2.1.pdf See Location of Data Files on page 99

The Universal Target provided with your Curve Pilot installation contains vignettes for the
process colors (C,M,Y,K), a CMY-composed gray vignette, and two gray square areas composed
of a fixed cyan percentage with varying magenta and yellow compositions. These two gray
squares(dark and light) are used in estimating gray balance.

 

 

Note:  The Universal Target provided with your Curve Pilot installation does not include
vignettes of spot colors for Equinox (o,g,b,..). If you need to measure spot colors for Equinox or
any other special inks, perform automated measurements using the appropriate chart layout.

11.5.  Control Strips for Equinox
The following table summarizes the control strips provided with Curve Pilot to support Equinox
printing conditions. When starting an automated measurement, these control strip layouts can
be selected from the Layout list.

Strip

Layout ESKO_CMYK_Gray_Control_Strip_i1iO_1row_Sep_value.it8

PDF ESKO_CMYK_Gray_Control_Strip_i1iO_1row_Sep_value.pdf
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Type Single-row (suitable for the i1iO measuring device)

Comments Contains patches for C, M, Y, K tones and ink solids, G7 composed CMY
gray and CMY solid, Red (M+Y), Green (C+Y), Blue (C+M)

Strip

Layout ESKO_CMYK_Gray_Control_Strip_i1_1row_Sep_value.it8

PDF ESKO_CMYK_Gray_Control_Strip_i1_1row_Sep_value.pdf

Type Single-row (suitable for the i1 measuring device)

Comments Contains patches for C, M, Y, K tones and ink solids, G7 composed CMY
gray and CMY solid

Strip

Layout ESKO_CMYK_Gray_Control_Strip_i1_2rows_Sep_value.it8

PDF ESKO_CMYK_Gray_Control_Strip_i1_2rows_Sep_value.pdf

Type Double-row (suitable for the i1iO and i1 measuring devices)

Comments Contains the same patches as
ESKO_CMYK_Gray_Control_Strip_i1iO_1row_Sep_value.it8
spread over two rows

Strip

Layout ESKO_Single_Ink_Control_Strip_Sep.it8

ESKO_Single_Ink_Control_Strip_Blue_Sep_value.pdf

ESKO_Single_Ink_Control_Strip_Green_Sep_value.pdf

PDF

ESKO_Single_Ink_Control_Strip_Orange_Sep_value.pdf

Type Single-row, single-ink

Comments Contains different tints and the solid patch for one ink.

Note:  There are PDF files available for orange, green, and blue, but the
control strip can also be used to print other inks. Curve Pilot will detect
the ink automatically from the ink solid patch on the strip. However,
this ink must be one of the inks available in the ClassicColors CMS
ink book.

This strip can be measured in combination with Esko CMYK strips,
to derive curves for process colors and one or more Equinox colors
(o,g,b,v,…)

Strip

Layout ESKO_Spot_Control_Strip_Sep.it8

PDF ESKO_Spot_Control_Strip_Sep_value.pdf
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Type Single-row, single-ink

Comments Contains different tints and the solid patch for one spot color ink.

Note:  The layout file is a sample for Pantone 7452C. You should make
separate layout files for each spot color that is going to be measured
following the procedure in New Control Strips for Spot Colors on page
105.

11.5.1.  New Control Strips for Spot Colors

To create a new control strip layout for a spot color and add it to Curve Pilot:

1. Open the Curve Pilot data folder, i.e. C:\Esko\bg_data_intellicurve_v160.
2. Make a copy of the ESKO_Spot_Control_Strip_Sep.it8 layout file.
3. Make sure that the spot color code is reflected in the file name, e.g. name the file

ESKO_Spot_Control_Strip_P7462C.it8 if you are creating a layout file for Pantone
7462C.

4. Edit this file with a standard text editor, and change the value of the PROCESSCOLOR_ID
field, which defines the spot color. For Pantone 7462C, the PROCESSCOLOR_ID line should
read:

PROCESSCOLOR_ID "pms1000c/7462"

where pms1000c is the inkbook name.
5. Save the file, and use it with Curve Pilot. You will need to close and reopen the Automatic

Measurement dialog so that the Layout list is updated.

11.6.  Measuring Devices
Curve Pilot can work with densitometers, spectrophotometers, or spectrodensitometers.

• You can use a densitometer for measuring a universal target or a control strip of a production
sheet manually.

• For automated measurements, you need a spectrophotometer.
• If you have a spectrodensitometer, you can use it either as a densitometer (using its

density measurement function) or as a spectrophotometer (using its spectral measurement
function).

Note:  For consistency and accuracy, we recommend you always use the same measuring
device in your workflow (with the same measurement condition set on it, if it supports several
measurement conditions).

Supported Spectrophotometers
You can use one of the following spectrophotometers to perform automated measurements in
Curve Pilot / PressSync Pilot:

• X-Rite i1,
• X-Rite i1iO,
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• X-Rite eXact / eXact Scan.

Note:

• You need to calibrate the eXact Scan on your substrate before each measurement / set
of measurements (for all measurement conditions except M1).

• If your eXact spectrophotometer doesn't have scan support (or a manual scan mode),
you can only perform single measurements with it.

You cannot use it to measure large charts (such as IT874 charts).

11.7.  Measurement Conditions
Your measuring device can have one or more measurement conditions.

What is a Measurement Condition?
Measurement conditions have been introduced by the printing industry to correct
measurement variations caused by optical brightening agents in newer substrates.

Measuring a substrate containing optical brightening agents with a light source containing
ultraviolet radiation causes fluorescence, making the substrate appear "whiter than white".
The more UV is in the light source, the higher the fluorescence, and the whiter the substrate
appears.

Different measurement conditions correspond to different amounts of UV, and will give
different Lab values for the white point (which also affects printed inks).

• M0 represents an incandescent lamp close to CIE's (Commission Internationale de
l'Eclairage) "Standard Illuminant A", with a color temperature of about 2856 K.

This is the measurement condition still used by most of the world's spectrophotometers
and densitometers.

As M0 does not define how much UV is in the light source, it is not recommended to use it
to measure substrates with optical brightening agents (that cause fluorescence), especially if
you need to exchange measurement data between facilities (that may use different types of
spectrophotometers).

• M1 represents a light source matching CIE's "Illuminant D50", but with a controlled amount
of UV radiation, and compensating for the fluorescence caused by that radiation. Note
that this compensation is only valid for measuring optically brightened papers, but not for
measuring fluorescent inks or toners.

• M2 represents a light source that excludes UV radiation (like a UV filter), so that substrates
with optical brightening agents can be measured without fluorescence under this
measurement condition.

• M3 excludes UV radiation too, but also contains a polarization filter, which reduces the
measurement differences between wet and dry samples, by minimizing the extra reflection
from the "glossy" surface of the wet ink.
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Attention:

For consistent results, we recommend you always use the same measurement
condition (also when exchanging measurement data between facilities).

This is especially critical when measuring your substrate several times (as different
measurement conditions will give different Lab values for the white point), but also
when measuring profiles, spot colors...

Different spectrophotometers have different measurement conditions available. For example,
older versions of the X-Rite i1 and i1iO spectrophotometers only support M0.

11.8.  The .it8 (CGATS) File Format
The .it8 (CGATS) file format is text-based. Curve Pilot can use the .it8 file format to save/
export and import measured data.

Imported .it8 data files may contain LAB, XYZ, and/or spectral data. Multi-channel data files
or files that contain spot colors are also supported.

When non-CMYK inks are used, the inks must be specified as extra fields in the file. These inks
must be known to the CMS, and each ink must be defined in the file in a separate line. The
required syntax is:

PROCESSCOLOR_ID "inkbook/inkname"

The data file shown below comes from an automatic measurement system that measured 5
inks: the process inks C,M,Y,K and the Pantone 722 Coated.

ORIGINATOR Cartonnages - AutoMeasurementFromPress
FILE_DESCRIPTOR Jobname: OF23408, SheetNumber: 1, Press Name:R706
CREATED 13-Jan-2012 11:36:16
TARGET_TYPE ANSI     IT8.7/4
COPYRIGHT            NA
PRINT_CONDITIONS     See ANSI CGATS/GRACoL TR 006-2007
ILLUMINANT           D50
MEASUREMENT_GEOMETRY 0/45
OBSERVER             CIE 2 degree
SAMPLE_BACKING       White
PROCESSCOLOR_ID      Cyan
PROCESSCOLOR_ID      Magenta
PROCESSCOLOR_ID      Yellow
PROCESSCOLOR_ID      Black
PROCESSCOLOR_ID      "PMS1000C/722"
NUMBER_OF_FIELDS     40
BEGIN_DATA_FORMAT
SAMPLE_ID            PC5_1 PC5_2 PC5_3 PC5_4 PC5_5 LAB_L LAB_A LAB_B NM_400 ...
END_DATA_FORMAT
NUMBER_OF_SETS       224
BEGIN_DATA
1   0   0   0 100   0  17.67  1.87     0.13   1.78   2.73   1.84  2.48
2 100   0   0   0   0  57.79  -33.52 -45.33  33.58  43.77  51.84  57.92
3   0 100   0   0   0  50.11  68.93   -6.62  20.81  22.64  24.23  26.27
4   0   0 100   0   0  85.62  -2.7   100.91   2.37   2.43   1.66   2.09
5   0   0   0   0 100  77.54  13.79   24.3   32.92  32.83  33.89  33.3
6   0  75   0   0   0  58.13  56.66  -10.33  30.17  31.77  35.12  37.29
7   0   0  75   0   0  87.12  -6.06   74.24  12.84  10.79   9.39   9.11
8   0   0   0   0  25  86.55  4.94     6.98  51.66  55.72  61.14  63.33
9   0   0   0 100   0  16.39  1.32     0.25   0.95   1.76   2.16   2.26

The Pantone color is defined last with PROCESSCOLOR_ID "PMS1000C/722", and its
composition in the patches (%) is shown in the 5th column (PC5_5) of the measured data.
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To calculate dot gain compensation curves for all inks in the data file, there must be enough
patches composed from single inks, and a solid (100%) patch for each ink defined in the .it8
file.

Similarly, if you want to base dot gain compensation on gray balance, there must be enough
gray patches in the file. These gray patches need to have neutral CMY compositions as
defined in the Neutral Gray CMY Triplet Table by G7. Only patches that are close to neutral gray
compositions (+/- 1%) will be extracted from the .it8 file.

11.8.1.  Control Strip Layouts and .it8 (CGATS) Files

To use an .it8 strip layout with Curve Pilot, some extra data must be defined in the file:

Field Name Example Value Unit Description

CGATSKEY_LAYOUT_TYPE Esko

NUMBER_OF_STRIPS 12 Number of rows to measure

NUMBER_OF_COLS 25 Number of columns to measure

PATCH_WIDTH 9 mm Width of a patch, including border
and gaps

PATCH_HEIGHT 8 mm Height of a patch, including border
and gaps

GAP_SIZE_X 1 mm Gap between patches in a row

GAP_SIZE_Y 0 mm Gap between patches in a column

MIRROR_X 1 mm Indicates if columns need to be
mirrored

BORDER_PATCHES 0 mm Border around patches

Each patch must have a proper C,M,Y,K composition, and the order of patches listed in the
.it8 file must be the same as the order of patches on the chart, starting from the first row and
continuing for each column in a left-to-right direction.

You can learn more about the .it8 format by examining one of the control strip layouts
provided with your Curve Pilot installation. See Location of Data Files on page 99 in Curve
Pilot.

11.9.  Curve Fitting Options
You can influence the way a PressSync curve is matched to a calculated DGC curve (calculated
compensation points). Select either Robust or Standard under the Curve fit list in the Curve
Pilot curve editing window.

You can decide on the most suitable fitting method based on the number of data points in
your measured data sets. The following table can be used as a guideline.
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You measure... Other factors Use

Control strips containing a
limited number of patches

NA Standard

Measured data are relatively smooth;
printing conditions are stable and
measurements reliable

StandardProfiles or control strips
containing a large number of
patches

Measured data are not smooth
due to printing instabilities and/or
measurement errors

Robust

For detailed information, see Robust Fit and Standard Fit below.

Robust Fit
A PressSync curve is selected so that the sum of absolute deviations between y values of the
calculated compensation points and y values on the PressSync curve is minimal:

     Mean Deviation (MD) = min Σ|Ydata–Ycurve| 

The result of this fit is that adjustment points following a normal trend relative to a PressSync
curve will fit the curve very well, while other points that deviate from this trend will be left
aside. The PressSync curve will tend to follow common points and ignore outliers.

With this method, multiple solutions are possible for some groups of points. This can result in
unstable curve fitting.

Standard Fit
A PressSync curve is selected so that the sum of squared deviations between y values of the
calculated compensation points and y values on the PressSync curve is minimal:

     Standard Deviation (SD) = min Σ((Ydata–Ycurve)^2)

The result of this fit is a curve that fits all data points equally well. The PressSync curve will tend
to follow all points (equally weighted). Data points that do not follow the average behavior of
other points will have a significant impact on the shape of the curve.

With this method, fitting may not be robust with respect to outliers. But there will be only one
solution (optimal curve) for a given group of points, so fitting will be stable.

11.10.  Tone Curve Exchange Data (TED) Files

A .ted file is an xml file based on international standards (ISO 18620) for the exchange of tone
curve data between software applications.

A .ted file can contain any number of tone curves corresponding to any number of inks/
separations. Tone curves are also known as 'transfer' curves or 'plate' curves.

The key xml element within a .ted file is TransferCurve and its key attribute (property) is
Separation. Data are specified as x, y pairs in the [0-1] range.

The rules for converting .ted files into .icpro strategies are simple:
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1. A TransferCurve element with Separation="Cyan|Magenta|Yellow|Black" is
converted into a Curve Pilot dot gain compensation (DGC) curve for the separation value
(Cyan, Magenta, Yellow, or Black).

2. A TransferCurve element with Separation="All" is converted into a Curve Pilot DGC
curve for Other Inks.

3. A TransferCurve element with Separation="<InkName>" is converted into a Curve Pilot
DGC curve for the <InkName> ink in the Designer inkbook.

Below is a sample .ted data file for reference.

<?xml version="1.0" encoding="UTF-8"?>
<TransferCurveSet xmlns="http://www.npes.org/schema/ISO18620/"
 Creator="My Press Calibration Software"
 CreationDate="2013-04-09T17:08:30-05:00"
 OperatorName="Samuel Adams"
 PressName="My Printing Press"
 MediaName="Standard Coated paper"
 Side="Front"
 MeasurementFile="d:\tmp\data.txt"
 TransferCurveSetID="CRD-24-3">
 <FormPreparationDetails Description="Euclidean screen"/>
 <PrintingCondition PrintingConditionID="Fogra39"/>
 <TransferCurve Separation="Cyan" TransferCurveID="C_0100"
  PrintingUnitNumber="1"
  Curve="0.0 0.0 0.5 0.4 1.0 1.0" />
 <TransferCurve Separation="Black"
  TransferCurveID="K_0100"
  PrintingUnitNumber="2"
  Curve="0.0 0.0 1.0 1.0" />
 <TransferCurve Separation="KitKat Red"
  TransferCurveID="KKR_0100"
  Curve="0.0 0.0 0.1 0.2 0.5 0.6 0.8 0.9 1.0 1.0" />
 <TransferCurve Separation="All" TransferCurveID="A1l_0100"
  Curve="0.0 0.0 0.1 0.15 0.5 0.65 0.8 0.95 1.0 1.0" />
</TransferCurveSet>

11.11.  PressSync Templates Based on the ISO 12647
Standards

Curve Pilot provides a number of .prsync templates based on desired printing conditions
(profiles) derived from the ISO 12647-2 or ISO 12647-3 standards.

Within this family of .prsync templates, desired Lab values for CMYK patches, paper, and
solids are calculated using Fogra characterization data for standardized printing conditions.

PressSync Template cmyk_Equinox

Application Offset Lithography

Paper Type ISO 12647-2 Types 1&2: high weight coated (HWC) matte, semi-
matte, or glossy; typical density 80-250 g/m2

Desired Printing
Condition

ISOcoated_v2_300_eci.icc

Target DGC curves FOGRA A (CMY) and B (K) as defined in ISO 12647-2:2004

PressSync Template cmyk_FOGRA51

Application Offset

110



11Curve Pilot

PressSync Template cmyk_FOGRA51

Paper Type ISO 12647-2:2013 Print Substrate 1: premium coated with
moderate fluorescence (8 to 14 DeltaB according to ISO 15397);
typical density 115 g/m2

Desired Printing
Condition

PSOcoated_v3.icc (measured with the M1 measurement condition)

Target DGC curves FOGRA A (CMY and K) as defined in ISO 12647-2

PressSync Template cmyk_FOGRA52

Application Offset

Paper Type ISO 12647-2:2013 Print Substrate 5: wood-free uncoated white with
high fluorescence (more than 14 DeltaB according to ISO 15397);
typical density 120 g/m2

Desired Printing
Condition

PSOuncoated_v3_FOGRA52.icc (measured with the M1
measurement condition)

Target DGC curves FOGRA C (CMY and K) as defined in ISO 12647-2

PressSync Template cmyk_ISO_Newsprint

Application Heatset Web Offset Printing

Paper Type Standard News Print (SNP): standard newspaper; typical density
40-52 g/m2

Desired Printing
Condition

PSO_SNP_Paper_eci.icc

Target DGC curves FOGRA C (CMY) and D (K) as defined in ISO 12647-2:2004

PressSync Template cmyk_ISO_PT1&2 (NP)

Application Offset Lithographic Processes

Paper Type ISO 12647-2 Types 1&2: high weight coated (HWC) matte, semi-
matte, or glossy; typical density 80-250 g/m2

Desired Printing
Condition

PSO_Coated_300_NPscreen_ISO12647_eci.icc

Target DGC curves FOGRA F (CMYK) as defined in ISO 12647-2:2004

Notes For typical stochastic (non-periodic/NP) screening

PressSync Template cmyk_ISO_PT1&2

Application Offset Lithographic Processes

Paper Type ISO 12647-2 Types 1&2: high weight coated (HWC) matte, semi-
matte, or glossy; typical density 80-250 g/m2

Desired Printing
Condition

ISOcoated_v2_300_eci.icc

Target DGC curves FOGRA A (CMY) and B (K) as defined in ISO 12647-2:2004
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PressSync Template cmyk_ISO_PT3

Application Offset Lithographic Processes, Web

Paper Type ISO 12647-2 Type 3: standard light weight coated (LWC) paper;
typical density 48-80 g/m2

Desired Printing
Condition

PSO_LWC_Standard_eci.icc

Target DGC curves FOGRA B (CMY) and C (K) as defined in ISO 12647-2:2004

PressSync Template cmyk_ISO_PT4

Application Offset Lithographic Processes, Web

Paper Type ISO 12647-2 Type 4: wood free uncoated white paper; typical
density 80-250 g/m2

Desired Printing
Condition

PSO_Uncoated_ISO12647_eci.icc

Target DGC curves FOGRA C (CMY) and D (K) as defined in ISO 12647-2:2004

PressSync Template cmyk_ISO_PT5

Application Offset Lithographic Processes, Web

Paper Type ISO 12647-2 Type 5: uncoated yellowish recycled paper; typical
density 110-120 g/m2

Desired Printing
Condition

ISOuncoatedyellowish.icc

Target DGC curves FOGRA C (CMY) and D (K) as defined in ISO 12647-2:2004

PressSync Template cmyk_ISO_WEB

Application Offset Lithographic Processes, Web

Paper Type Super calendered (SC) offset paper for web; typical density 38-60 g/
m2

Desired Printing
Condition

ISOwebcoated.icc

Target DGC curves FOGRA B (CMY) and C (K) as defined in ISO 12647-2:2004
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Note:

To use one of these templates successfully:

• make sure that you use the ICC profile defined as "Desired Printing Condition" as reference
profile in your color management (import it in your color database if it doesn't contain it yet
- see Importing Profiles in the Color Pilot documentation for details),

• if a measurement condition is specified in the template, make sure you use a measuring
device that supports that measurement condition.

When creating a curve set from such a template, its measurement condition is saved in
the curve set setup, and automatically set on your measuring device when performing
measurements for that curve set (unless your measuring device doesn't support this
measurement condition).

See Measurement Conditions on page 106 for information about the different
measurement conditions.

For example, when using cmyk_FOGRA51, you need to use PSOcoated_v3.icc as reference
profile, and a device supporting M1.

11.12.  PressSync Templates Based on the G7
Calibration Method

Curve Pilot provides a number of .prsync templates based on desired printing conditions
derived from industrial specifications such as GRACoL, SNAP, and SWOP.

Within this family of .prsync templates, desired Lab values for gray patches, paper, and solid
are gray-balanced and calculated using the G7 calibration methodology.

PressSync Template 3ck_Equinox

Application Commercial Offset Lithography

Paper Type ISO 12647-2 Types 1&2: high weight coated (HWC) matte, semi-
matte, or glossy; density 80-250 g/m2

Desired Printing
Condition

GRACol2006_Coated1v2.icc

Target DGC curves GRACoL G7 (3C+K)

PressSync Template 3ck_GRAColG7

Application Commercial Offset Lithography

Paper Type ISO 12647-2 Types 1&2: high weight coated (HWC) matte, semi-
matte, or glossy; density 80-250 g/m2

Desired Printing
Condition

GRACol2006_Coated1v2.icc

Target DGC curves GRACoL G7 (3C+K)
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PressSync Template 3ck_SNAP

Application Newsprint & Advertising

Paper Type As per ISO 12647-3:2005 (newsprint paper)

Desired Printing
Condition

SNAP2007.icc

Target DGC curves GRACoL G7 (3C+K)

PressSync Template 3ck_SWOP

Application Web Offset Publications

Paper Type ISO 12647-2 Type 3 : light weight coated (LWC) paper, web

Desired Printing
Condition

SWOP2006_coated3_GCR_bas.icc

Target DGC curves GRACoL G7 (3C+K)

11.13.  Linear Dot Gain PressSync Templates
Curve Pilot provides two .prsync templates containing target curves for linear dot gain.

cmyk_LinearColor.prsync is a true linear curve, where 50% prints at 50%,
cmyk_LinearDensity.prsync is a "classic" linear dot gain curve, where 50% prints at 68%.

Those curves are not based on a standard but will give you a good result in most cases (and a
dot gain close to most standards).

11.14.  User Defined Dot Gain Curves for Process Colors
To generate a User Defined dot gain curve for a process color:

1. Go to the Process Colors tab of the Setup dialog.
2. If the Desired <Value> on Universal Target panel is collapsed, click on  to expand it.

Note:  <Value> will be one of density, %DotArea, ΔE-P, or %ΔE-P, depending on the setting
in the Measure list.

3. If you are working with a cmyk_ template, enter the desired values for Cyan, Magenta,
Yellow, or Black for the ¼ (25%), ½ (50%), and ¾ (75%) patches.

If you are working with a 3ck_ template, enter the desired values for CMY (3c gray) or Black
for the ¼ (25%), ½ (50%), and ¾ (75%) patches.

4. If the Desired <Value> on a Control Strip panel is collapsed, click on  to expand it.
5. Edit the number of Patches present in the control strip layout. This number refers to

intermediate patches only (excluding paper and solid). The default number of intermediate
patches is 3.

6. If you want to customize the intermediate patch compositions, enter the desired Tones
under Patch 1, ..., Patch n, where n is the number of intermediate Patches set above.
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7. If you are working with a cmyk_ template, enter the desired values for Cyan, Magenta,
Yellow, or Black for Patch 1, ..., Patch n.

If you are working with a 3ck_ template, enter the desired values for CMY (3c gray) or Black
for Patch 1, ..., Patch n.

Note:  Curve Pilot will calculate the best fitting desired dot gain curve from both data sets, i.e.
the values entered for the Universal Target and the values entered for the Control Strip.

11.15.  User Defined Dot Gain Curves for Spot Colors
To generate a User Defined dot gain curve for a spot color:

1. Go to the Spot Colors tab of the Setup dialog.
2. If the Desired <Value> on Universal Target panel is collapsed, click on  to expand it.

Note:  <Value> can be one of density, %DotArea, ΔE-P, or %ΔE-P, depending on the setting
in the Measure list.

3. Select a spot color under the Spot Colors list.
4. Enter the desired values for the ¼ (25%), ½ (50%), and ¾ (75%) patches.
5. If the Desired <Value> on a Control Strip panel is collapsed, click on  to expand it.
6. Edit the number of Patches present in the control strip layout. This number refers to

intermediate patches only (excluding paper and solid). The default number of intermediate
patches is 3.

7. If you want to customize the intermediate patch compositions, enter the desired Tones
under Patch 1, ..., Patch n, where n is the number of intermediate Patches set above.

8. Enter the desired values for Patch 1, ..., Patch n.

Note:  Curve Pilot will calculate the best fitting desired dot gain curve from both data sets, i.e.
the values entered for the Universal Target and the values entered for the Control Strip.

11.16.  Migration Tool for SCRDGC Files

The screen-based DGC strategy format (.scrdgc) has been replaced by the .icpro DGC
strategy format. The selection and use of existing .scrdgc files in all Esko workflows is still
supported, but you have to migrate them to .icpro if you want to edit them.

To migrate individual .scrdgc files, select File > Import > SCRDGC on the Curve Pilot main
menu.

Importing screen-based strategies one by one can be time-consuming. The Migration Tool
enables you to automatically upgrade all existing screen-based strategy files in the central
location of DGC data to the .icpro strategy format in one go.

Your original .scrdgc files are first automatically backed up to a subfolder of the DGC data
folder. Following conversion, the original .scrdgc files can be deleted from their original
location. If you choose to do so, do not forget to update all references in your tickets and
FlexRip configurations from the old .scrdgc files to the new .icpro ones. Your RIP output is
guaranteed to remain the same.

115



11 Curve Pilot

Note:  Screen-based DGC files created by Color Engine Pilot for proofing or factory screen-
based strategies for proofing will not be touched or upgraded by this tool.

To migrate your .scrdgc files follow the procedure below. The instructions assume that
your Curve Pilot application is installed locally under C:\Esko, and that DGC data are located
centrally under \\server\bg_data_dgc_v010.

1. Run C:\Esko\bg_prog_intellicurve_v160\bin_ix86\migratescrdgc.exe.

The following MS Dos window appears:

 

 
2. Follow the instructions on the screen for each step: type y for yes and n for no.
3. When you check the \\server\bg_data_dgc_v010\scrdgcBackup folder, you can see

that the old .scrdgc files are backed up in that folder.

11.17.  Neutral Gray CMY Triplet Table

Gray (%) C (%) M (%) Y (%)

0.00 0.00 0.00 0.00

1.96 1.96 1.18 1.18

3.92 3.92 2.75 2.75

5.88 5.88 4.31 4.31

7.84 7.84 5.49 5.49

10.20 10.20 7.45 7.45

14.90 14.90 10.98 10.98

20.00 20.00 14.90 14.90
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Gray (%) C (%) M (%) Y (%)

25.10 25.10 18.82 18.82

30.20 30.20 23.14 23.14

34.90 34.90 27.06 27.06

40.00 40.00 31.37 31.37

45.10 45.10 35.69 35.69

49.80 49.80 40.00 40.00

54.90 54.90 45.10 45.10

60.00 60.00 50.20 50.20

65.10 65.10 55.29 55.29

69.80 69.80 60.39 60.39

74.90 74.90 65.88 65.88

80.00 80.00 71.76 71.76

85.10 85.10 78.04 78.04

89.80 89.80 84.31 84.31

94.90 94.90 92.16 92.16

98.04 98.04 96.86 96.86

100.00 100.00 100.00 100.00
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12.  Glossary
BLACK MASK

When making flexo plates with an Esko CDI, a black mask will come out of the machine. This is
the non-processed black flexo plate which has not been washed out yet.

CGATS

CGATS is the Committee for Graphic Arts Technologies Standards.

CONTINUOUS TONE IMAGE (CT)

A continuous tone image (also called a contone image) is an unscreened image which is
composed by pixels containing 256 possible gradient tones, varying from white (0) to black
(256). The most common example is a photograph.

CONVENTIONAL SCREEN

A conventional screen, also called AM (amplitude modulated) or traditional screen, is a screen
where the dots are placed on a fixed grid and where the dot sizes vary according to tonal
differences: bigger dots simulate darker tonal values, while smaller dots simulate lighter tonal
values.

The Esko variant of conventional screening is called Classic screening.

DOT GAIN (DG)

Dot gain is a phenomenon in printing where halftone dots are printed fatter than desired
and/or expected. By applying a method of dot gain compensation, this phenomenon can be
controlled.

DOT GAIN COMPENSATION (DGC)

Dot gain compensation is a technique that consists of reducing halftone dots on the film, in
order to compensate the expected dot sizes on the print.

DGC STRATEGY

A DGC Strategy is a combination of various single Dot Gain Compensation Curves, which are
applied accordingly to parts with different screens in a job. DGC Strategies replace the former
Screen Based DGC curves.

DPI

DPI stands for dots per inch and refers to the output resolution of a printer or an image setter.
However, DPI does not refer to the resolution of a halftone image, which is referred to as LPI.

FILM – DIGITAL FILM

The difference between a film and a digital film is the fact that a film refers to the physical
film created by a film setter, while a digital film refers to a bitmap file created by a RIP, e.g. a
screened Tiff file provided by FlexRipT4.

FLEXO PRINTING
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Flexo printing or flexography is a rotary printing process that uses flexible photopolymer plates
which contain a raised image (relief). The inked plates are rotated on a cylinder, in order to
transfer the image to a substrate.

In flexo printing, fast-drying inks are used, so the process is ideal for printing on foils and
plastics. Flexo is mainly used in the packaging market.

FOGRA

Fogra (full name Fogra Forschungsgesellschaft Druck e.V.) is a German-based graphic industry
research association.

GRACoL®

GRACoL® (General Requirements for Applications in Commercial Offset Lithography) is a set of
guidelines and recommendations to streamline the workflows between print buyers and print
service suppliers.

GRAVURE PRINTING

Gravure printing (also rotogravure printing) is a rotary printing process whereby an image
is engraved in a copper cylinder. The engraving of the image on the plate is done by a laser
etching or a diamond tipped machine, which etches millions of small cells in the cylinder.

HALFTONE IMAGE

A halftone image is the printed simulation of a contone (continuous tone) image, using black or
white dots, that can vary in size, to simulate the continuous tone image in the print. See also:
screening.

ICC

ICC is the International Color Consortium.

LPI

LPI or Lines per inch is the resolution of a halftone print. The higher the LPI, the sharper the
print. LPI is also referred to as the screen ruling.

OFFSET PRINTING

Offset printing is a printing technique that uses the principle of the lithographic process: the
cylinder which carries the image contains two parts: one part that repulses water and attracts
oil (the image part), and a part that repulses oil and attracts water (the non-printing part).

PIXEL

A pixel (or picture element) is the smallest component of an image reproduced on a screen,
such as a TV screen or a computer screen. The combination of many pixels forms an image.

PLATE

A plate or printing plate is a plate which is provided by the plate setter and contains the
positive or negative image that has to be transferred to the paper or other substrate. A plate
can be made of metal (offset), rubber, polymer (flexo)...

To be ready to be put on a printing press, the plate needs to be processed or prepared by a
chemical process. A processed plate is a plate that has been washed out and dried.

PPI
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PPI stands for pixels per inch and refers to the resolution of a computer monitor, a scanner, a
digital photo camera or a photograph.

SAMBAFLEX

SambaFlex by Esko is a hybrid (transitional) screening technology combining AM screening in
the mid-tones and FM screening in the highlights and (optionally) in the shadows.

SCREENING

Screening is the process of converting a grayscale image into a pattern of small dots with a
limited number of inks. Screening is sometimes called halftoning.

SNAP

SNAP (Specifications for Newsprint Advertising Production) is a set of specifications designed to
improve reproduction quality in proofing and coldset printing by offset lithography on webs of
newsprint grade paper (newspapers, pre-printed advertising inserts, etc.)

SWOP®

SWOP® (Specifications for Web Offset Publications) is a color reproduction specification for
web offset lithography managed by IDEAlliance.

STOCHASTIC SCREEN

A stochastic or FM (frequency modulated) screen is a screen where the dots are placed
randomly and not on a fixed grid. The number of dots varies according to the tonal differences:
to simulate lighter tonal areas, less dots are placed, while more dots are placed to simulate
darker tonal areas.

The Esko variant of stochastic screening is called Monet screening.

TRANSITION ZONE

Besides conventional and stochastic screens, there are also transitional screens, e.g. Esko's
SambaFlex screens.

These are screens which have a stochastic part in highlights and shadows, and a conventional
part in the midtones. In between is a transition zone, which contains a pattern that is gradually
going from stochastic to conventional over a very big number of intermediate patterns.
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